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 INTRODUCTION  
The introduction is always written last. After updating 38 chapters, I 

reflect back on the things that simply knocked my socks off in this version 

of Excel. 

For people who are new to Excel: 

 • The Flash Fill and Quick Analysis features will be huge timesavers. 

Read about those features in Chapter 2, “Introducing Flash Fill and 

Quick Analysis.” 

 • The new JavaScript Excel App Store holds a lot of promise. A few good 

apps are there right now. Microsoft is currently training more people to 

write apps, so hopefully by the time you are reading this, there will be 

many more apps. Read about apps in Chapter 5, “Extending Excel with 

Excel Apps and Add-Ins.” 

For people who use Excel every day: 

 • After you create a chart, a paintbrush icon appears to the right of the 

chart. That icon offers 10 different ways to format the chart. They 

are all fabulous. This comes close to my favorite new feature in Excel 

2013. It certainly wins the award for “the feature that I wasn’t expect-

ing to be amazing, but it was.” Read about the charting changes in 

Chapter 32, “Graphing Data Using Excel Charts.” 

 • The Recommended Pivot Table feature is good—using this feature can 

trim the six clicks it usually takes to create a pivot table down to four 

clicks. Pivot tables are covered in Chapter 23, “Using Pivot Tables to 

Analyze Data.” 
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 • PowerPivot evolves and becomes part of the core of Excel in this release. I gushed about it in 

Excel 2010. It actually gets a little harder to use in this release, but that’s okay. For more informa-

tion, read Chapter 25, “Mashing Up Data with PowerPivot.” 

 • Power View enables you to take data stored in the PowerPivot model and do some amazing visu-

alizations. Maps, pictures, tables, dashboards, and more are discussed in Chapter 26, “Creating 

Interactive Dashboards with Power View or GeoFlow.” 

 • The most improved award for this version goes to the Excel Web App team. Excel Web Apps 

break new ground, enabling you to conduct surveys online, turn boring web pages into interac-

tive gems, and more. Sometimes, I don’t know what to tweet. Now that I can share my favor-

ite spreadsheets to Twitter and LinkedIn via the Web App, I might be posting more to social 

media. Read about Excel Web Apps in  Chapter 37, “Excel Web App and Other Ways to Share 

Workbooks.” 

For Excel gurus: 

 • The new WEBSERVICE and  FILTERXML functions for returning data from a web service will be 

put to good use. Read about them in Chapter 12, “Using Powerful Functions: Logical, Lookup, 

Web, and Database Functions.” 

Microsoft marketing will be crowing a lot about the new Start screen ( Chapter 1, “Staying 

Connected Using Excel 2013”) and Timelines ( Chapter 24, “Using Slicers and Filtering a Pivot 

Table”). I cover them both but also tell you how to live without them. 

     How This Book Is Organized  
The book is organized into the following parts: 

 • Part I , “Mastering the New User Interface”—This first part of the book shows you the ribbon, 

Flash Fill, the Quick Analysis, the big grid, and the new Excel App Store. 

 • Past II , “Calculating with Excel”—This part covers what Excel does best, from formulas to func-

tions to linking. 

 • Part III , “Business Intelligence”—Sorting, filtering, subtotals, pivot tables. These are the tools 

of the Excel data analyst. Learn about these tools and the new PowerPivot add-in in Part III. The 

chapter on VBA macros is also in this part of the book. 

 • Part IV , “Visual Presentation”—This part covers charting, SmartArt, data visualizations, and 

picture tools. After you get done analyzing the data, a few features from this part will make your 

reports look good. 

 • Part V , “Sharing Information”—This part discusses printing and sharing your Excel workbooks 

by creating PDFs or publishing to the Web. 
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  Conventions Used in This Book  
The special conventions used throughout this book are designed to help you get the most from the 

book as well as Excel 2013. 

  Text Conventions  
Different typefaces are used to convey various things throughout the book. They include those 

shown in Table  I.1.

  Table I.1   Typeface Conventions  

  Typeface     Description   

Monospace Screen messages and Excel formulas appear in  monospace.

Italic New terminology appears in  italic.

Bold References to text you should type appear in bold.

Ribbon names, dialog names, and dialog elements are capitalized in this book (for example, Add 

Formatting Rule dialog, Home ribbon tab). 

In this book, key combinations are represented with a plus sign. If the action you need to take is to 

press the Ctrl key and the T key simultaneously, the text tells you to press Ctrl+T. 

There were not many changes from Excel 97 to Excel 2000 to Excel 2002 to Excel 2003. Most people 

upgrading to Excel 2013 will be coming from one of these versions of Excel. I collectively refer to 

these versions as “legacy versions of Excel.” 

  Special Elements  
Throughout this book, you’ll find tips, notes, cautions, cross-references, case studies, Excel in 

Practice boxes, sidebars, and Troubleshooting Tip boxes. These elements provide a variety of infor-

mation, ranging from warnings you shouldn’t miss to ancillary information that will enrich your 

Excel experience but isn’t required reading. 

 Tip 
 Tips point out special features, 
quirks, or software tricks that 
will help you increase your pro-
ductivity with Excel 2013.  

 Note 
 Notes contain extra information 
or alternative techniques for per-
forming tasks.  

 Caution 
 Cautions call out potential 
 gotchas.  

        See  Chapter   99    for more information is a cross-reference to another section or chapter 

in this book.        
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 Case Study: Other Elements  

 Sections such as Case Study, Excel in Practice, and Troubleshooting Tips are set off in boxes 
such as this one:  

    •   Case Studies walk you through the steps to complete a task.   

   •   Excel in Practice boxes walk through real-life problems in Excel.   

   •   Troubleshooting Tip boxes walk you through steps to avoid certain problems or explain 
how to react when certain problems occur.    

 Sidebars  

 Historical glimpses and other information that is not critical to your understanding appear as 
sidebars. I imagine that if the Cliff Clavin character from  Cheers  knew a lot about Excel, these 
would be the kinds of things he would write.  
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 USING THE EXCEL INTERFACE  
The Excel interface has had a major makeover over the last decade. Excel 

2007 introduced the ribbon and Quick Access Toolbar to replace the famil-

iar command bar at the top of Excel. Excel 2010 brought the expanded 

File menu. Excel 2013 brings the Start menu, plus new Open and Save 

As panes. These were discussed in Chapter 1, “Staying Connected Using 

Excel 2013.” This chapter reviews all of the remaining Excel interface 

elements.

     Using the Ribbon  
The ribbon is composed of seven permanent tabs labeled Home, Insert, 

Page Layout, Formulas, Data, Review, and View. Other permanent tabs 

appear if you install certain add-ins. For example, PowerPivot, Inquire, and 

Easy-XL are tabs that you see if you install certain add-ins. Other contex-

tual ribbon tabs appear when you select a certain type of object, such as a 

chart, image, or pivot table. 

Each tab is broken into rectangular groups of related commands. The 

group shown in Figure 3.1 is the Clipboard group on the Home tab. 

The mantra of the ribbon is to use pictures and words. Many people have 

seen the little whisk broom icon in previous versions of Excel but never 

knew what it did. In Excel 2013, the same icon has the words “Format 

Painter” next to it. When you hover, the tooltip offers paragraphs explain-

ing what the tool does. The tooltip also offers a little-known trick: You can 

double-click the Format Painter to copy the formatting to many places. 
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  Using Fly-out Menus and Galleries  
The ribbon fits more commands in a smaller space by using new types of controls that were not 

available with the Excel 2003 menu bar and toolbars. 

In Figure 3.1, the Cut icon is a pure command. You click the icon and Excel cuts the selection onto 

the Clipboard. In contrast, the Paste and Copy icons are a new type of element comprised of a but-

ton and a drop-down. If you click the top half of Paste or the left side of Copy, you invoke the com-

mand. But if you click the arrow in either icon, you get a fly-out menu with more choices. 

Fly-out menus allow many choices from a single icon. For example, the Conditional Formatting icon 

on the Home tab takes up a 76×76 pixel area on the ribbon. Clicking Conditional Formatting leads 

to five new fly-out menus and three commands. In all, the fly-out menus lead to a total of 64 distinct 

commands, all driven from a single 76×76-pixel icon (see Figure 3.2).

Another new element in the ribbon is the gallery control. Galleries are used when there are dozens 

of options from which to choose. The gallery shows you a visual thumbnail of each choice. A gallery 

starts out showing a row or two of choices in the ribbon. The right side of the gallery offers icons for 

up, down, and open. If you click up or down, you scroll one row at a time through the choices (see 

Figure 3.3).

If you click the open control at the bottom-right side of the gallery, the gallery opens to reveal all 

choices at once (see Figure 3.4).

 Figure 3.1 
 Detail of the Clipboard group of the Home tab of the ribbon.        
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 Figure 3.2 
 Fly-out menus offer dozens of choices from 
a single icon.        

 Figure 3.3 
 Use the up and down 
arrows on the right 
side of the gallery 
to move one row at 
a time through the 
choices.        

 Figure 3.4 
 If you open the gallery con-
trol, you can see all of the 
choices at one time.        
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    Rolling Through the Ribbon Tabs  
With Excel as the active application, move the mouse anywhere over the ribbon and roll the scroll 

wheel on top of the mouse. Excel quickly flips from ribbon tab to ribbon tab. Scroll away from you to 

roll toward the Home tab on the left. Scroll toward you to move to the right. 

  Revealing More Commands Using Dialog Launchers, Task Panes, 
and “More” Commands  

The ribbon holds perhaps 20% of the available commands. The set of commands and options avail-

able in the ribbon will be enough 80% of the time, but you will sometimes have to go beyond 

the commands in the ribbon. You can do this with dialog launchers, “More” commands, and the 

task pane. 

A dialog launcher is a special symbol in the lower-right corner of many ribbon groups. Click the dia-

log launcher to open a related dialog with many more choices than those offered in the ribbon. 

Figure 3.5 shows details of the Number group of the Home tab. In the lower-right corner is the dia-

log launcher. It looks like the top-left corner of a dialog, with an arrow pointing downward and to 

the right. 

When you click the dialog launcher, you go to a dialog box that often offers many more choices than 

those available in the ribbon. In Figure 3.6, you see the Number tab of the Format Cells dialog. 

Many menus in the ribbon end with an entry for “More  blank...” or “ Blank Options...”. You will see 

menu options for More Rules..., Effects Options..., and so on. Look for these menu items as the last 

entry in many menus. Clicking a More item takes you to a dialog or task pane with far more choices 

than those available in the ribbon. 

Figure 3.7 shows the More Rules menu item, which leads to the New Formatting Rule dialog. 

 Figure 3.5 
 The dialog launcher takes you to additional 
options.        
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Charts in Excel 2013 show a plus icon to the right of the selected chart. This icon leads to fly-out 

menus that eventually lead to a “More...” menu item (see Figure 3.8). When you select More... from 

a chart, you go to a redesigned task pane. Task panes were popular in Excel 2003. They were nearly 

 Figure 3.6 
 After clicking the dialog launcher, you 
get access to far more choices.        

 Figure 3.7 
 Choosing More Rules leads to a dialog with more choices.        
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banished in Excel 2007 due to the edict that all commands must be at the top. However, they are 

back with a vengeance in Excel 2013. 

Task panes typically appear on the right side of the Excel win-

dow, although you can undock them and have them float above 

the worksheet. After a task pane appears, it typically stays visible 

until you close it by clicking the X button. Figure 3.9 shows a task 

pane for formatting the chart title. If you click a data label in the 

chart, the task pane changes to show options for chart labels. If 

you click a picture, SmartArt, or WordArt, the task pane changes 

to show options for the newly selected object. 

 Figure 3.8 
 Choosing More... from the chart’s plus icon leads to a 
task pane.        

 Figure 3.9 
 The Format dialog from Excel 2010 is now a task pane.        

 Caution 
 If you click away from an object 
and choose only a cell, the 
task pane stays visible with the 
choices for the last selected 
object. However, all of the 
choices are grayed out. This 
seems like a bug to me.  
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For charts, the task pane in Excel 2013 replaces the Format dialog from Excel 2010. It seems more 

confusing to use the task pane. 

In Excel 2010, the Format dialog had a list of categories down the left side. These categories were 

arranged into groups with a horizontal separator between categories. For example, in  Figure 3.10,

the first group of categories is Fill, Border Color, and Border Styles. In a glance, you could see other 

categories such as Glow and Soft Edges, Properties, and Alt Text. I appreciated seeing a long list of 

words to choose from. 

The Excel 2013 task pane offers a hierarchy of words, icons, and more words. In Figure 3.11, the 

equivalent task pane starts with two sets of words at the top: Chart Options and Text Options. It 

won’t be obvious in the figure, but Chart Options is shown in green and is the currently selected 

 Tip 
 To display the task pane for an object, press Ctrl+1. Although it is easy to display the task pane for a chart, it is not obvi-
ous how to display the task pane for an image or WordArt. However, as noted earlier, you can accidentally find your way 
to the Picture task pane by clicking a picture while the task pane is active. When you want to display a task pane but 
cannot figure out how to do it, try F1.  

 Figure 3.10 
 The Format 
dialog from 
Excel 2010 
offered easy-
to- understand 
words in the 
left navigation 
pane.        
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choice. When Chart Options is selected, you have three icons: a paint bucket, a pentagon with a 

reflection, and a square that someone appears to be measuring. Again, it is not obvious from the 

figure, but the paint bucket is in green and selected. When the  paint bucket is selected, two word 

choices appear in the task pane: Fill and Border. Click the triangle next to either word to show all of 

the choices for that word. Figure 3.12 shows the Border category after expanding. 

Level 1: Words

Level 2: Icons

Level 3: Words

 Figure 3.11 
 The task pane offers a three-level menu of words, 
icons, and then more words.        

 Figure 3.12 
 After choosing Chart Options, the paint bucket, and then Border, you get 
these options.        
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The task pane is confusing because you can’t see all of the categories at one time. You will find 

yourself trying to guess which Level 1 word to choose and then clicking through each of the Level 2 

icons trying to find the Level 3 category you want. 

Figure 3.13 shows the name of each Level 2 icon and the types of categories you might find there. 

    Resizing Excel Changes the Ribbon  
The ribbon appears different as the size of the Excel application window changes. You should 

be aware of this when you are coaching a co-worker over the phone. You might be looking at 

your screen and telling him to “look for the big Insert drop-down to the right of the orange word 

Calculation.” Although this makes perfect sense on your widescreen monitor, it might not make 

sense on his monitor.  Figure 3.14 shows some detail of the Home tab on a widescreen monitor. The 

Cell Styles gallery shows 10 thumbnails, and Insert, Delete, and Format appear side-by-side. 

Figure 3.15 shows the typical view on a laptop. The Cell Styles gallery is collapsed to a single drop-

down. The Insert, Delete, and Format icons are now arranged vertically. 

 Figure 3.13 
 Icons you might find in various task panes.        

 Figure 3.14 
 On a wide-
screen moni-
tor, you see 
10 choices in 
the Cell Styles 
 gallery.        
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As you resize the Excel screen, more items collapse. In Figure 3.16, the three icons for Insert, Delete, 

and Format are collapsed into a single drop-down called Cells. 

New in Excel 2013, you can even coax a new right-arrow icon to scroll the ribbon right (see 

Figure 3.17).

Eventually, the Excel ribbon gets too small, and Excel hides the ribbon completely (see  Figure 3.18).

 Figure 3.15 
 On a normal monitor, the cell styles gallery is collapsed.        

 Figure 3.16 
 At small sizes, icons collapse into drop-downs.        

The > Icon

 Figure 3.17 
 Click the right-arrow icon to scroll the ribbon to the right.        

 Figure 3.18 
 When the Excel windows gets too narrow, the ribbon is hidden.        
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    Activating the Developer Tab  
If you regularly record or write macros, you might be looking for the VBA tools in the ribbon. They 

are all located on the Developer tab, which is hidden by default. However, it is easy to make the 

Developer tab visible. Follow these steps: 

 1. Right-click the ribbon and choose Customize the Ribbon. Excel displays the Customize Ribbon 

category of the Excel Options dialog. 

 2. A long list box of ribbon tabs is shown on the right side of the screen. Every one of them is 

checked except for Developer. Check the box next to Developer. 

 3. Click OK. The Developer tab displays. 

  Activating Contextual Ribbon Tabs  
The ribbon tabs you see all the time are called the main tabs. Another 18 tabs come and go, depend-

ing on what is selected in Excel. 

For example, Excel offers a whole series of commands for dealing with photographs that you insert 

into your worksheet. However, 90% of people never bother to dress up their worksheets with clipart 

or pictures, so there’s really no reason to show all the commands for working with photographs on 

the ribbon. However, after you insert a picture and the picture is selected, the Picture Tools, Format 

tab appears in the ribbon (see Figure 3.19).

The 18 contextual tabs are identified in Figure 3.20.

Here is the frustrating thing: As soon as you click outside of the object (that is, the picture), it is no 

longer selected and the Picture Tools Format tab disappears. 

If you need to format an object and you cannot find the icons for formatting it, try clicking the object 

to see if the contextual tabs appear. 

Two other tabs occasionally appear, although Excel classifies them as main tabs instead of contex-

tual tabs. If you add the Print Preview Full Screen icon to the interface, you arrive at a Print Preview 

tab. Also, from the Picture Tools Design tab, you can click Remove Background to end up at the 

Background Removal tab. 

 Figure 3.19 
 Anywhere from one to three contextual ribbon tabs display when you activate certain 
objects.        
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  Finding Lost Commands on the Ribbon  
Often, the command you need is front and center on the Home tab and everything is fine. However, 

there are times when you simply cannot find an obscure command that you know used to be in 

Excel 2003. Here is my strategy for finding those commands: 

 1. Right-click the ribbon and select Customize Quick Access Toolbar. Excel displays the Quick 

Access Toolbar category of the Excel Options dialog. 

 2. Open the top-left drop-down and change Popular Commands to All Commands. You now have an 

alphabetical list of over 2,000 commands. 

 3. Scroll through this alphabetical list until you find the command you are trying to locate in the 

ribbon.

 4. Hover over the command in the left list box. A tooltip appears, 

showing you where you can find the command. In Figure

3.21, the Justify command is located on the Home tab, in the 

Editing group, under the Fill drop-down. 

Microsoft offers a free interactive ribbon guide that can help 

you locate an Excel 2003 menu command on the ribbon. Type 

Interactive Ribbon Guide in any search engine to find the latest 

incarnation of the ribbon guide. I’ve seen the guide and tried it 

out once, but given that the tooltips are built into the Customize 

Quick Access Toolbar panel of Excel Options, it seems pointless 

to go out to the Web when you can find the answer quickly using 

the steps just outlined. 

 Figure 3.20 
 This table shows which tabs appear and 
when.        

 Note 
 Sometimes, a command truly 
is not in the ribbon. If you 
hover over a command in the 
Customize dialog and the tooltip 
indicates that this is a com-
mand that is not in the ribbon, 
you have to use Customize to 
add this command to the Quick 
Access Toolbar or to the ribbon.  
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    Shrinking the Ribbon  
The ribbon does take up four vertical rows of space. This won’t 

be an issue on a big monitor, but it could be an issue on a tiny 

netbook.

Starting in Excel 2013, to shrink the ribbon, you can right-click 

the ribbon and choose Collapse the Ribbon. The ribbon collapses 

to show only the ribbon tabs. When you click a tab, the ribbon 

temporarily expands. To close the ribbon, choose a command or 

press Esc. 

To permanently bring the ribbon back to full size, right-click a rib-

bon tab and uncheck Collapse the Ribbon. 

Note that you can also minimize the ribbon using the carat (^) icon 

at the bottom right of the expanded ribbon. To expand the ribbon, 

click any tab and then click the pushpin icon in the lower-right cor-

ner of the ribbon. 

  Using the Quick Access Toolbar  
A problem with the ribbon is that only one-seventh of the commands are visible at any given time. 

You will find yourself moving from one tab to another. The alternative is to use the Quick Access 

Toolbar (QAT) to store your favorite commands. 

The QAT starts out as a tiny toolbar with Save, Undo, and Redo. It is initially located above the File 

tab in the ribbon. 

If you start using the QAT frequently, you can right-click the toolbar and choose Show Quick Access 

Toolbar Below the Ribbon. 

Command (Drop-Down)GroupRibbon Tab

 Figure 3.21 
 This tooltip shows you where to 
find a command.        

 Tip 
 Starting in Excel 2013, the rib-
bon often stays open after 
certain commands. For example, 
I frequently click the Increase 
Decimal icon three times in a 
row. When the ribbon is mini-
mized, you can click Home and 
then click Increase Decimal three 
times without having the ribbon 
close.  
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  Adding Icons to the QAT  
The drop-down at the right side of the QAT, shown on the right side in  Figure 3.22, offers 12 popular 

commands you might choose to add to the Quick Access Toolbar. Choose a command from this list 

to add it to the QAT. 

Note that changes to the QAT made in Excel 2010 also appear in Excel 2013, and vice versa. The 

Open Recent File icon is no longer available in Excel 2013, but if you add it to the QAT in Excel 

2010, it appears in Excel 2013. Unfortunately, the icon simply goes to the File, Open pane. 

When you find a command in the ribbon you are likely to use often, you can easily add the command 

to the QAT. To do so, right-click any command in the ribbon and select Add to Quick Access Toolbar. 

Items added to the Quick Access Toolbar using the right-click method are added to the right side of 

the QAT. 

The right-click method works for many commands, but not with individual items within commands. 

For example, you can put the Font Size drop-down on the QAT, but you cannot specifically put size 

16 font in the QAT. 

  Removing Commands from the QAT  
You can remove an icon from the QAT by right-clicking the icon and selecting Remove from Quick 

Access Toolbar. 

  Customizing the QAT  
You can make minor changes to the QAT by using the context menus, but you can have far more 

control over the QAT if you use the Customize command. Right-click the QAT and select Customize 

Quick Access Toolbar to display the Quick Access Toolbar section of the Excel Options dialog, as 

shown in Figure 3.23.

 Figure 3.22 
 Use the drop-down at the right side of the 
QAT to add 12 popular commands.        
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The Excel Options dialog offers many features for customizing the Quick Access Toolbar: 

 • You can choose to customize the QAT for all documents on your computer or just for the current 

workbook by using the top-right drop-down menu. 

 • You can add separators between icons to group the icons logically. A separator icon is available 

at the top of the left menu. Click the separator icon in the left list box and then click the Add>> 

icon in the center of the screen. 

 • You can resequence the order of the icons on the toolbar. Select an icon in the right list box and 

then click the up/down arrow icons on the right side of the dialog. 

 • You can access 2,000+ commands, including the commands from every tab and commands that 

are not available in the ribbon. Although the dialog starts with just 53 popular commands in the 

left list box, use the left drop-down to choose All Command or Commands Not in the Ribbon. 

When you find a command in the left list box, select the command and then click Add>> in the 

center of the dialog to add that command to the QAT. 

 • You can reset the QAT to its original default state using the Reset button in the lower right. 

 • You can export your custom QAT icons from your computer and import on another computer. 

 • You can move the QAT to appear above or below the ribbon using the check box in the 

lower right. 

 Figure 3.23 
 You can cus-
tomize the QAT 
using the Excel 
Options dialog.        
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  Assigning VBA Macros to Quick Access Toolbar Buttons  
Typically, a VBA macro is assigned to a shortcut key. In legacy versions of Excel, it was easy to cus-

tomize the menu system to add commands to invoke macros. Excel 2013 offers a weak interface for 

adding custom macros to the QAT. In the Excel Options dialog is a drop-down called Macros. If you 

select this group, you see all public macros in all open workbooks. You can select a macro and click 

Add to add that macro to the QAT. 

Initially, every macro added to the Quick Access Toolbar gets an identical flowchart icon. However, 

you can select an icon in the Customize Quick Access Toolbar list box and click the Modify button. 

The Modify Button dialog that appears enables you to choose from 55 available icons for a macro 

as shown in Figure 3.24. Most of these buttons are similar to icons that are already popular. For 

example, the Print icon is fairly well known and has a meaning. In addition to choosing from the 55 

icons, you can type any text for a display name. The display name  does not appear next to the but-

ton. However, if you hover your mouse over the icon on the QAT, you can see the display name in 

a tooltip. 

 Figure 3.24 
 For macros, you 
can customize 
the button image 
and add a display 
name on the QAT.        
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     Using the Full-Screen File Menu  
Open the File menu in Excel 2013 and you might be shocked to see that it takes up 100% of your 

screen real estate. This panel is called the Backstage view and was introduced in Excel 2010. Here 

is the logic: When you are working on most ribbon tabs, you are working in your document. When 

you are about to change the font or something like that, you want to see the results of the change 

for the “in” commands. However, the Excel team feels that after you move to the File menu, you are 

done working in your document  and you are about to do something with the whole document, such 

as send the workbook, print the workbook, post the workbook to Twitter, and so on. Microsoft calls 

these the “out” commands. The theory is that you don’t need to see the worksheet for the “out” 

commands, so Microsoft fills the entire screen with the File menu. 

To open the Backstage view, click the File menu. The Backstage view fills the screen, as shown in 

Figure 3.25. Backstage is split into three sections: the narrow left navigation panel and two wider 

sections that provide information. 

The left navigation panel includes these commands: 

 • Info—Provides information about the current workbook. This is discussed later in the “Getting 

Information About the Current Workbook” section. 

 • New—Used to create a new workbook or start from a template. Discussed in  Chapter 1.

 Figure 3.25 
 The Backstage view 
fills the entire screen.        
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 • Open—Used to access a file stored on your computer or the SkyDrive. Discussed in Chapter 1.

 • Save—Saves the file in the same folder as it was previously stored. Note that Save is actually a 

command instead of a panel in Backstage. 

 • Save As—Stores the file on your computer or in the SkyDrive. Discussed in Chapter 1.

 • Print—Used to choose print settings and print. Includes Print Preview. Discussed in  Chapter 36,

“Printing.”

 • Share—Used to post your workbook to Facebook, Twitter, or LinkedIn or to send it via email. 

Discussed in Chapter 36.

 • Export—Used to create a PDF, control web publishing options, or change the file type. Discussed 

in Chapter 37, “Excel Web App and Other Ways to Share Workbooks.” 

 • Close—Closes the current workbook. Like Save, this entry is a pure command. 

 • Account—Connects your copy of Excel to various social networking accounts. Discussed in 

Chapter 1.

 • Options—Contains pages of Excel settings. See Chapter 4, “Customizing Excel,” for details. 

 • Recent File List—This list appears only if you’ve changed a default setting in Excel Options. 

Visit File, Options, Advanced Display and choose Quickly Access This Number of Recent 

Workbooks. 

  Pressing the Esc Key to Close Backstage View  
To get out of Backstage and return to your worksheet, you can either press the Esc key or click the 

back arrow in the top-left corner of Backstage. 

  Recovering Unsaved Workbooks  
As in previous versions of Excel, the AutoSave feature can create copies of your workbook every 

n minutes. If an AutoSave version of your workbook exists, you can now access that file using 

the Recover Unsaved Workbooks icon at the bottom of the Recent Workbooks list. Note that you 

might have to scroll down to the bottom of the Recent Workbooks list to find the Recover Unsaved 

Workbooks icon (see  Figure 3.26).

Do you ever get to the end of your workday, use Alt+F+X to close Excel, and then are greeted with 

a barrage of Do You Want to Save questions? I frequently forget that the  nth workbook that I have 

open is not saved. I think that I had opened these workbooks to get information, that I had not made 

any significant changes, and will either start clicking Don’t Save repeatedly or will hold down Shift 

and click Don’t Save, which is equivalent to clicking the nonexistent Don’t Save to All selection. 

As I see that important file get closed, I realize that I just lost all my changes to that file and cringe. 

This is a common problem that happens to everyone sooner or later. Provided that the file was open 

long enough to experience an AutoSave, you might be able to get the file back. 
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Go to Recover Unsaved Workbooks and find the date and time of the last AutoSave. It might be 

within 5 minutes of the last time you edited a cell in that document. When you find the file and open 

it, the Information Bar reports that this is a “recovered unsaved file” (see  Figure 3.27). Click Save As 

to give the file a name. 

    Clearing the Recent Workbooks List  
If you need to clear out the Recent Workbooks list, you should visit File, Options, Advanced, Display. 

Set the Show This Number of Recent Documents list to zero. This is unlike the behavior in Excel 

2003. In Excel 2003, to clear out the ninth item from the list, you had to reset only the number of 

files back to eight and Excel would forget about the ninth. In Excel 2013, if you switch from 50 

 Figure 3.26 
 If you set Excel to display more 
recent workbooks than will 
fit on the screen, you have to 
scroll down to find the Recover 
Unsaved Workbooks icon.        

 Figure 3.27 
 Excel recovers the file. You 
need to use Save As to make 
the recovery permanent.        



Using the Excel Interface68

I

PA
R
T

files to one file, then back to 50 files, all 50 files will come back. The only way to clear the Recent 

Workbooks list is  to set the value back to zero. You can then reset it to 50 and Excel will start col-

lecting history again. 

  Getting Information About the Current Workbook  
When a workbook is open and you go to the File menu, you start in the Info gallery for that 

workbook. As shown in Figure 3.28, the Info pane lists all sorts of information about the 

current  workbook:

 • The workbook path is shown at the top of the center panel. 

 • You can see the file size. 

 • You can see when the document was last modified and who modified it. 

 • If any special states exist, these will be reported at the top of the middle pane. Special states 

might include the following: 

   • Macros not enabled 

   • Links not updated 

   • Checked out from SharePoint 

 Figure 3.28 
 The Info gal-
lery includes 
all of the prop-
erties of the 
file.        
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 • You can see if the file has been AutoSaved and recover those AutoSaved versions. 

 • You can mark the document as final, which will cause others opening the file to initially have a 

read-only version of the file. 

 • You can edit links to other documents. 

 • You can add tags or categories to the file. 

 • Using the Check for Issues drop-down, you can run a compatibility checker to see if the work-

book is compatible with legacy versions of Excel. You can run an accessibility checker to see if 

any parts of the document will be difficult for people with disabilities. You can run a Document 

Inspector to see if any private information is hidden in the file. 

  Marking a Workbook as Final to Prevent Editing  
Open the Protect Workbook icon in the Info gallery to access a setting called Mark as Final (see 

Figure 3.29). This marks the workbook as read-only. It prevents someone else from making changes 

to your final workbook. 

 Figure 3.29 
 Mark a document as read-only.        
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Of course, if the other person visits the Info gallery, that person can reenable editing. This feature 

is simply designed to warn the other people that you’ve marked it as final and no further changes 

should happen. 

If you can convince everyone in your workgroup to sign up for a Windows Live ID, you can use the 

Restrict Permission by People setting. This layer of security enables you to define who can read, 

edit, and/or print the document. 

  Finding Hidden Content Using the 
Document Inspector  

The Document Inspector can find a lot of hidden content, but it is 

not perfect. Still, finding 95% of the types of hidden content can 

protect you a lot of the time. 

To run the Document Inspector, select File, Info, Check for Issues, 

Inspect Document, and click OK. The results of the Document 

Inspector will show that the document has personal information 

stored in the file properties (author’s name) and perhaps a hidden 

worksheet.

     Using Other Excel Interface 
Improvements  

This is a recap of interface changes introduced in Excel 2007 through Excel 2013: 

 • Slot-machining (2013)—When you change an input cell, all of the calculated cells in view of the 

window animate as they change. This looks a lot like the spinning wheel in a slot machine. 

 • Touch mode (2013)—If you are using Excel on a touch screen or a tablet, you can put Excel in 

touch mode. A tiny bit of space appears around each icon, which hopefully gives you more of a 

chance to touch the correct icon. 

 • Less chrome (2013)—Microsoft really believes a lot of people will be using Excel on touch devices 

once Windows 8 begins to catch on. They tried to make the touch zones bigger by eliminating 

any decorations in the interface. Microsoft called these decorations the “chrome” in the interface. 

In addition to losing the chrome, you also lose some tiny icons that would be hard to use in touch 

mode. For example, the tiny icons in the edge of the scrollbars used to split a window are gone 

in Excel 2013. The set of four controls used to move between worksheets is reduced to  two icons. 

 • Paste options (2010)—An expanded Paste Options menu introduces many popular shortcut key 

sequences to Excel. 

 Caution 
 The Document Inspector is not 
foolproof. Do you frequently hide 
settings by changing the font 
color to white or by using the 
;;; custom number format? This 
won’t be found by the Document 
Inspector. The Document 
Inspector also won’t note that 
you scrolled over outside the 
print area and jotted your after-
work grocery list in column X.  
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 • Live preview (2007)—You can preview formatting changes before you actually select the change. 

 • Mini toolbar (2007)—The mini toolbar appears whenever you select text. Although this might 

happen rarely when you edit cells in Excel, it does happen frequently when you work with 

charts, text boxes, and so on. The mini toolbar offers quick access to font, size, bold, italic, align-

ment, color, indenting, and bullets. 

 • Formula bar (2007)—The formula bar includes the capability to expand or contract itself at your 

whim instead of the whim of Excel. 

 • Zoom slider (2007)—The Zoom slider enables you to quickly change from seeing one page to 

hundreds of pages at a time. 

 • Status bar (2007)—The status bar appears at the bottom of your worksheet window. Although 

you probably never noticed it, the status bar in legacy versions of Excel reported the total of any 

selected cells. This information is now improved and expanded, offering multiple statistics at one 

time.

 • View control (2007)—The View control gives you one-click access to Page Break Preview mode, 

Normal mode, and the Page Layout view introduced in Excel 2007. 

 • New Sheet icon (2007/2013)—The New Sheet icon enables you to add new worksheets to a 

workbook with a single click. In Excel 2013, the new sheet is added to the right of the active 

sheet.

  Adding White Space Around Icons Using Touch Mode  
If you are trying to use Excel on a tablet or a touch screen, you want to try touch mode. Follow these 

steps:

 1. Go to the right side of the QAT and open the drop-down that appears there. 

 2. The twelfth command is called Touch Mode. The icon is a blue dot with a ring of white space 

and then dashed lines around the white space. Choose this command to add it to the QAT. 

 3. Click the icon on the QAT. You see white space added around all of the icons. 

Figure 3.30 compares the first two groups of the Home tab in regular and touch mode. 

 Note 
 As a public service to you, the reader, I went out and bought a Planar touch screen so I could try the touch gestures 
in Excel. Other than having some fun scribbling using the Ink tools, there really isn’t any good reason to have a touch 
screen in Excel. However, one hot August day, I was writing this book and a house fly zoomed past me and landed on the 
touch screen. It landed with enough force to select cell C33, which I thought was pretty funny. Had it actually typed a 
 VLOOKUP  formula, it would definitely be the most proficient  Excel house fly ever.  
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     Previewing Paste Using the Paste Options Gallery  
Here’s a quick survey: Have you ever opened a Notepad window, pasted your data to Notepad, 

copied from Notepad, and then pasted to your application? This is a great but tedious way to 

remove formatting from a selection. If you have discovered this painful workaround, you are going 

to love this feature that was added starting in Excel 2010: the Paste Options gallery. 

Here is another survey: Suppose you have to copy a column of formulas and paste them as  values.

Do your fingers know how to do Ctrl+C, Alt+E+S+V+Enter? If so, you are going to love the new 

Ctrl+V, Ctrl, V keystrokes available in the Paste Options gallery. If you’ve ever done Ctrl+C, 

Alt+E+S+V+Enter, Alt+E+S+T+Enter, you will love the new Context+E keyboard shortcut. 

As someone who uses both of those old keyboard shortcuts frequently, I love the Paste Options gal-

lery. You can keep slicers, sparklines, even PowerPivot; the Paste Options gallery is going to be the 

one feature that makes a difference in my life every single hour of every single workday. 

Microsoft discovered that Paste was the number-one command that was immediately followed by 

Undo. To improve the Paste command, Microsoft added the Paste Options gallery in three places in 

Excel 2010. These galleries support Live Preview and keyboard shortcuts. They should make mouse-

centric as well as keyboard-centric people very happy. 

 Figure 3.30 
 Touch mode adds white space around each icon, 
thus making the touch points larger.        
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You encounter the gallery when you have something on the Clipboard and one of these three 

events happens: 

 • You right-click a cell to access the context menu. 

 • You open the Paste drop-down from the Home tab. 

 • After you perform a typical Paste operation, the old Paste Repair menu icon appears with the tip 

that you can press Ctrl to access the gallery. 

  Accessing the Gallery After Performing a Paste Operation  
Suppose that you copy a range with Ctrl+C and then paste with Ctrl+V. The icon for the old Paste 

Repair appears next to the paste, but this time it notes that you can open the menu by pressing Ctrl. 

When you press Ctrl, you are presented with a gallery of paste options. 

The options available in the gallery are as follows: 

 • Paste—This is the standard paste that you would get using Ctrl+V. 

 • Formulas—Pastes only formulas, with no formatting. This is common when you are copying 

down from the first row of a table that has an outline border. To prevent the top border from 

copying, you can paste formulas. You then find that you have to reapply the number formatting. 

 • Formulas & Number Formatting—Copies formulas as previous formulas, along with the number 

formatting. 

 • Keep Source Formatting—This is particularly useful when copying from another application such 

as a web page. The formatting from the other application is pasted along with the values. 

 • No Borders—Pastes everything but the borders. 

 • Column Widths—Includes the column widths from the copied area. 

 • Transpose—Turns the data on its side. A 12-row-by-1-column copied range would paste as 1 row 

by 12 columns. 

 • Values—Converts formulas to values. 

 • Values and Number Formatting—Converts the formulas to values and includes the number for-

mats from the copied data. 

 • Values & Source Formatting—Converts the formulas to values and includes all formatting such 

as cell styles, font color, number formatting, and borders. 

 • Formats—Does not bring any values, only the cell formatting. Similar to using the Format Painter 

but not as annoying. 

 • Paste Link—Creates formulas here that point back to the copied range. 

 • Paste as Picture—Pastes a picture of the original cells in this location. 
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 • Paste as Linked Picture—Pastes a live picture of the original cell in this location. This is the elu-

sive Camera tool from Excel 2003. 

 • Open Paste Special—Used to access the old Paste Special dialog. The Paste Special dialog still 

offers some choices not available in the Paste Options gallery: Comments, Validation, All using 

Source Theme, Add, Subtract, Multiply, Divide, and Skip Blanks. 

  Accessing the Paste Options Gallery from the Right-Click Menu  
The Paste Options gallery appears in the right-click context menu and includes Live Preview. The 

top six options appear directly in the menu. A fly-out menu offers all 14 options. 

As you start to hover over the various paste icons, Live Preview takes over. The rest of the context 

menu disappears so that you can see the worksheet. Hover over Transpose, and you get a preview 

of what Transpose actually does. Hover over Formatting and you see that the Formatting option 

copies only the cell formats and not the numbers. If you hover over Paste Special and then move out 

to the full gallery, all the context menu except the full gallery disappears, and Live Preview contin-

ues to work. 

 Why Keyboard-Centric People Like the Context Gallery  

 I am not a right-click person. I always use keyboard shortcuts instead of the mouse. I can press 
Alt+E+S+V+Enter before most people can even move their hand over to the mouse.  

 Take a close look at your keyboard. To the left of the spacebar, between the FN and Alt keys, do 
you have the Flying Windows key? I’ve memorized a few of its shortcuts, such as Win+E to open 
Windows Explorer. Now, look over to the right of the spacebar. What do you have between Alt 
and Ctrl there? I have a key that I had never used before today. This key looks like the right-click 
menu and is the Context Menu key. When I press that key in Excel, the right-click menu appears 
in the worksheet.  

 Those six icons in the Paste Options gallery in the right-click menu each have a keyboard accel-
erator:  

  P —Normal Paste  

  V —Paste Values  

  F —Formulas  

  T —Transpose  

  R —Formats  

  N —Paste Link  

 This means that there is an even faster keyboard method for converting formulas to values. 
Press Ctrl+C to copy, press the Context Menu key, and then press V to convert to values. You 
probably have to use two hands: Ctrl+C with the left hand, Context Menu key with the right 
hand, and V with the left hand. It takes a little practice until this is as fast as Ctrl+C, Ctrl+V, Ctrl, 
V, but it is worth a shot if you rely on keyboard shortcuts to speed your way through tasks.  
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    Accessing the Paste Options Gallery from the Paste Drop-Down  
The Paste Options gallery also appears when you open the Paste drop-down on the Home tab. 

Figure 3.31 shows the menu there. 

     Using the New Sheet Icon to Add Worksheets  
The Insert Worksheet icon looks different in Excel 2013 and behaves differently as well. The icon 

is a circle with a plus sign that appears to the right of the last sheet tab. It also looks like an aerial 

view of a Phillips-head machine screw. 

When you click this icon, a new worksheet is added to the right of the active sheet. This is better 

than Excel 2010, where the new worksheet was added as the last worksheet in the workbook and 

then had to be dragged to the correct position. 

  Navigating Through Many Worksheets Using the 
Controls in the Lower Left  

Previous versions of Excel had four controls for moving through the list of worksheet tabs. Due to 

the new “less chrome” mantra, the worksheet navigation icons are now a left and right arrowhead 

in the lower left (see Figure 3.32).

 Figure 3.31 
 The gallery replaces the old Paste drop-down in the Home tab.        

 Figure 3.32 
 These worksheet navigation controls have 
been streamlined in Excel 2013.        
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The controls are only active when you have more tabs than are visible across the bottom of the 

Excel window. Click the left or right icon to scroll the tabs one at a time. Ctrl+click either arrow to 

scroll to the last tab. Note that scrolling the tabs does not change the active sheet. It just brings 

more tabs into view so you can then click the selected tab. 

Just as in prior versions of Excel, you can right-click the worksheet navigation arrows to see a com-

plete list of worksheets. Click any item in the list to move to that worksheet. 

In certain circumstances, an ellipsis (...) icon appears in the worksheet navigation area. This icon 

selects the worksheet to the left of the active sheet. 

  Using the Mini Toolbar to Format Selected Text  
When you select some text in a chart title or within a cell, the mini toolbar appears above the 

selected text. If you move away from the mini toolbar, it fades away. However, if you move the 

mouse toward the mini toolbar, you see several text formatting options. 

In your initial use of Excel 2013, you might not see the mini toolbar. Although you often select cells 

or ranges of cells, it is rare to select only a portion of a cell value in Cell Edit mode. However, as you 

begin using charts, SmartArt diagrams, and text boxes, you will have the mini toolbar appearing 

frequently. 

To use the mini toolbar, follow these steps: 

 1. Select some text. If you select text in a cell, you must select a portion of the text in the cell by 

using Cell Edit mode. In a chart, SmartArt diagram, or text box, you can select any text. As soon 

as you release the mouse button, the mini toolbar appears above and to the right of the selection. 

 2. Move the mouse pointer toward the mini toolbar. The mini toolbar stays visible if your mouse is 

above it. If you move the mouse away from the mini toolbar, it fades away. 

 3. Make changes in the mini toolbar to affect the text you selected in step 1. 

 4. When you are done formatting the selected text, you can move the mouse away from the mini 

toolbar to dismiss it. 

  Getting the Mini Toolbar Back  
The shyness of the mini toolbar might be the most frustrating part of using it. If you move the 

mouse away from the mini toolbar, it fades away. If you immediately move back toward the mini 

toolbar, it comes back. If you use the mouse for some other task, such as scrolling, the mini toolbar 

permanently goes away. In this case, you might have to reselect the text to get the mini toolbar to 

come back. 

  Disabling the Mini Toolbar  
If you are annoyed by the mini toolbar, you can turn it off for all Excel workbooks. To do this, select 

File, Options. The first choice in Excel Options is a check box for Show Mini Toolbar on Selection. 

Clear this check box. 
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  Expanding the Formula Bar  
Formulas range from very simple to very complex. As people started writing longer and longer for-

mulas in Excel, an annoying problem began to appear: If the formula for a selected cell was longer 

than the formula bar, the formula bar would wrap and extend over the worksheet (see  Figure 3.33).

In many cases, the formula would obscure the first few rows of the worksheet. This was frustrating, 

especially if the selected cell was in the top few rows of the spreadsheet. 

Excel 2013 includes a formula bar that prevents the formula from obscuring the spreadsheet. For 

example, in Figure 3.34, cell F1 contains a formula that is longer than the formula bar. Notice the 

down-arrow icon at the right end of the formula bar. This icon expands the formula bar. 

Press Ctrl+Shift+U or click the down arrow icon at the right side 

of the formula bar to expand the formula bar. The formula bar 

expands, but the entire worksheet moves down to accommodate 

the larger formula bar. 

The formula in this example is too long for the default larger for-

mula bar. You have to hover your mouse near the bottom of the for-

mula bar until you see the up/down white arrow cursor. Click and 

drag down until you can see the entire formula (see  Figure 3.35).

 Figure 3.33 
 In legacy versions of Excel, the for-
mula bar could obscure cells on a 
worksheet.        

 Figure 3.34 
 Initially, Excel 
shows only the 
first row of the 
formula.        

 Note 
 Excel MVP Bob Umlas keeps sug-
gesting the formula bar should 
change color when you are not 
seeing the entire formula. That is 
a great suggestion that perhaps 
the Excel team will one day add 
to Excel.  



Using the Excel Interface78

I

PA
R
T

     Zooming In and Out on a Worksheet  
In the lower-right corner of the Excel window, a zoom slider enables you to zoom from 400% to 10% 

with lightning speed. You simply drag the slider to the right to zoom in and to the left to zoom out. 

The Zoom Out and Zoom In buttons on either end of the slider enable you to adjust the zoom in 10% 

increments.

Clicking the % indicator to the left of the zoom slider opens the legacy Zoom dialog. 

  Using the Status Bar to Add Numbers  
If you select several cells that contain numeric data and then look at the status bar, at the bottom 

of the Excel window, you can see that the status bar reports the average, count, and sum of the 

selected cells (see Figure 3.36).

If you need to quickly add the contents of several cells, you can select the cells and look for the total 

in the status bar. This feature has been in Excel for a decade, yet very few people realized it was 

there. In legacy versions of Excel, only the sum would appear, but you could right-click the sum to 

see other values, such as the average, count, minimum, and maximum. 

 Figure 3.35 
 The worksheet 
moves down to 
accommodate 
the formula.        

 Figure 3.36 
 The status bar shows the sum, average, and count of the 
selected cells.        
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You can customize which statistics are shown in the status bar. Right-click the status bar and 

choose any or all of Min, Max, Numerical Count, Count, Sum, and Average. 

Note that the panel might show values for items that you have recently unselected. These figures 

will be wrong if the selection has changed. 

  Switching Between Normal View, Page Break 
Preview, and Page Layout View Modes  

Three shortcut icons to the left of the zoom slider enable you to quickly switch between three view 

modes:

 • Normal view—This mode shows worksheet cells as normal. 

 • Page Break preview—This mode draws the page breaks in blue. You can actually drag the page 

breaks to new locations in Page Break preview. This mode has been available in several versions 

of Excel. 

 • Page Layout view—This view was introduced in Excel 2007. It combines the best of Page Break 

preview and Print Preview modes. 

In Page Layout view mode, each page is shown, along with the margins, header, and footer. A ruler 

appears above the pages and to the left of the pages. You can make changes in this mode in the fol-

lowing ways: 

 • To change the margins, drag the gray boxes in the ruler. 

 • To change column widths, drag the borders of the column headers. 

 • To add a header, select Click to Add Header. 
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1002-1019
content, 1010
styles, 1015-1016

formula, highlighting all, 
178-179

highlighting, Greater Than 
rules, 1004-1006

in-cell bar charts, creating, 
992-997

merging, 962-964
naming, 675-676
references

absolute, 147-148, 690
calculating in formula, 

658-662
mixed, 148

results, watching, 926-927
same formula, entering, 

156-159
selecting, keyboard 

shortcuts, 107-110
shapes, displaying content, 

1084-1087
symbols, inserting, 930
wrapping text, 980-981

centering reports, 1132

CHAR function, 206, 277-278

Chart Utilities add-in, 100

charting data, Quick Analysis, 
39-40

charts, 1021
adding data, tables, 1047
axis ranges, controlling, 

1035-1037
bubble, 1040
changing options, Plus icon, 

1027-1028
Chart Utilities add-in, 100
combo, showing two orders 

of magnitude, 1029-1033
deleting extraneous data, 

1023-1025
fitting into the size of a cell, 

sparklines, 1055-1056
formatting elements, 

1030-1033
labeling, 1033-1035
organizational, hierarchical 

SmartArt, 1081-1082
pasting data, 1046
pie, small slices, 1051-1052
PowerPoint, using in, 

1166-1167
recommended, 1022-1023
replicating, Power View, 851
rows, adding to, 46
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scatter
animating, 855-856
plotting two populations, 

1041-1043
variable relationships, 

1037-1043
stock, creating, 1050-1051
styles

Paintbrush icon, 
1023-1025

saving as templates, 
1052-1053

summarizing data, Quick 
Analysis, 1043-1046

surface, adding drop lines to, 
1048-1049

tables
converting to, 844-847
data, 714-715

trendlines, 1048-1049

Charts Category (Quick 
Analysis), 48

check boxes, filtering pivot 
tables, 791-792

CHISQ.TEST function, 506-508

CHOOSE function, 325

circles, calculating angles, 
564-565

CLEAN function, 206, 275-277

clearing
conditional formatting, 

1015-1016
filters, 737

Clip Art, inserting, from 
online, 1094-1096

Close command (File menu), 66

closed workbooks, opening, 
635

cloud, SkyDrive, 12-19

code, VBA, 897-902

CODE function, 206, 278-280

collapsed subtotal view, 
sorting, 754-755

collections, VBA (Visual Basic 
for Applications), 898

Collie, Rob, 852

color coding cells, Quick 
Analysis, 35-39

color scales, cells, applying to, 
997-999

coloring cells, 960-961

colors
data bars, displaying in two, 

1019
filtering data by, 739-741
sorting data by, 725
themes, 973-975

COLUMN function, 330-332

Column Widths option (Paste 
Options gallery), 73

columns
banded, creating, 719-721
blank, sorting data, 732
data, selecting, 710-713
duplicates, removing, 

748-750
identifying, filters, 736-737
sorting data, left-to-right, 

727
sorting left to right, Easy-XL 

utility, 1184
summing, while counting 

others, 758-759
text-to-columns feature, 

Easy-XL utility, 1182-1184
widths, adjusting, 961-962

COMBIN function, 199, 201, 233

COMBINA function, 199, 201,
233-234

combination layouts, 
PowerPivot, 837-838

combining
filters, 737
formulas, 656-658

combo charts, showing 
two orders of magnitude, 
1029-1033

commands
Advanced Filter, 745-746
Data Table, 863-865
Easy-XL utility, recording 

into VBA macros, 1188
File menu, 65-66

finding lost, 60
Goal Seek, 872-874, 876-877
keyboard shortcuts, 103,

107-112
accelerators, 103-107
calculating data, 112
commonly used, 116-117
data entry, 112
Excel 2003 accelerators, 

117-119
extending selections, 

107-111
formatting data, 112
legacy mode, 119
navigation, 109
selecting data and cells, 

107-110
Windows, 108

legacy dialog boxes, 
selecting, 106-107

Moving Average, 534
QAT (Quick Access Toolbar), 

removing from, 62
Subtotal, 751-759

commas, Flash Fill, 26-27

comments, printing, 1133

Compact Form, pivot tables, 
770-771

comparing documents side by 
side, synchronous scrolling, 
928

comparison operators, 300-302

COMPLEX function, 552,
576-577

complex numbers, 576-577
adding, 578
basic math, performing on, 

579-580
breaking apart, 577-578
calculating angles to, 582
calculations, 582-584
converting a and b into, 

576-577
distance from origin, finding, 

581
logarithms, calculating, 

582-584

compounding period, interest 
rates, calculating, 392-393
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Compress Pictures dialog, 1104

CONCATENATE function, 206

conditional formats, pasting, 
986

conditional formatting, 992
clearing, 1015-1016
combining rules, 1015-1016
comparing dates, 1007
duplicate values, identifying, 

1008
extending, 1016
formulas, 1011-1012
Highlight Cells Rules, 

1004-1009
pivot tables, 1016-1019
text containing values, 1009
top/bottom rules, 1002-1004
tweaking rules, 1009-1014
unique values, identifying, 

1008

Conditional Formatting Rules 
Manager dialog, 1001

CONFIDENCE.NORM function, 
520-522

connecting
to data on web pages, 

637-640
two worksheets, 627-636

connections
database access, setting up, 

645-646
managing, 650
ODBC, setting up, 646-649
OLE DB, setting up, 646-649
SQL Server, setting up, 

646-649
text files, setting up, 641-645
XML, setting up, 646-649

Context Menu, 74

contextual tabs (ribbon), 
activating, 59

CONVARIANCE.P function, 480

CONVERT function, 552,
595-610

copying
array formulas, 671
filtered results, 743-745

formats, 984-989
formulas, 172-174

fill handle, 158-159
table tool, 160-161

subtotal rows, 755-756

CORREL function, 481-482,
535-538

COS function, 551, 560-562

COSH function, 551, 567

cost, depreciation, 393

cost argument 
DB function, 395
DDB function, 396
SLN function, 394
SYD function, 397
VDB function, 397

COT function, 186, 551

COTH function, 186, 551, 568

COUNT function, 214-222

COUNTIF function, 201,
242-244

CountIf.3D function, 100

COUNTIFS function, 186,
244-246

COUPDAYBS function, 377

COUPDAYS function, 377

COUPDAYSNC function, 377

COUPNCD function, 377

COUPNUM function, 377

COUPPCD function, 377

Create Pivot Table dialog, 766

CSC function, 186, 551

CSCH function, 186, 551, 567

cube functions, 358-359

CUMIMPT function, 375

CUMIPMT function, 377,
390-391

CUMPRINC function, 375, 377,
391-392

current region, selecting, 
keyboard shortcut, 116

custom headers, adding, 
1125-1126

custom number formats, 
changing numeric formats, 
950-954

customization
ribbon, 84-85
sharing, 84

Customize Ribbon settings 
(Excel Options dialog), 85

cutting formulas, 172-174

Cycle category (SmartArt), 
1071

  D 
daily dates, grouping to 

months and years, pivot 
tables, 775-777

dashboards (Power View), 
creating, 843-851

data. See also records  
adding statistics to, Quick 

Analysis, 41-44
calculating, keyboard 

shortcuts, 112
charting, Quick Analysis, 

39-40
cleaning, Flash Fill, 21-33
columns, selecting, 710-713
entering, keyboard 

shortcuts, 112
formatting, keyboard 

shortcuts, 112
jumping to bottom, keyboard 

shortcut, 116
segregating, icon sets, 

999-1002
selecting, keyboard 

shortcuts, 107-110
sorting, 723, 725

blank columns, 732
case sensitivity, 726-727
by color, 725
custom lists, 727-729
by icon, 725
left-to-right, 727
one-click, 729-730
randomly, 730-732
Sort dialog, 724
troubleshooting, 731
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summary reports, creating, 
46

tables, defining suitable, 
700-705

Data Analysis Expressions 
(DAX). See DAX (Data 
Analysis Expressions) 

data analysis tasks, utilities, 
102

Data Analysis tools 
ANOVA (analysis of 

variance), 538-543
correlation, 535-537
covariance, 535-537
Exponential Smoothing 

feature, 535
F-test tool, 543-544
generating descriptive 

statistics, 529-530
generating histograms, 

527 529
generating random numbers, 

525-527
ranking results, 530-531
Regression tool, 531-533
Sampling dialog, 538
T-test tools, 546-547
Z-test tool, 545

data bars 
in-cell bar charts, creating, 

992-997
creating, 994-995
customizing, 995-996
displaying in two colors, 

1019

Data Filters, pivot tables, 
filtering, 793

data mapping, sparklines, 
1056-1067

Data Model 
joining multiple tables, 

813-821
limitations, 821
preparing data, 814-816

data ranges, coercing, array 
formulas, 670-671

Data Table dialog, 863-865

data visualization, 991-992
color scales, 997-999
data bars 

in-cell bar charts, 992-997
displaying in two colors, 

1019
icon sets, data segregation, 

999-1002

databases
access, connections, 645-646
functions, 295, 301, 366-367

DGET, 371-373
DSUM, 367-371

date and time 
displaying, 948
functions, 204-203, 252

DATE, 204, 254-255
DATEDIF function, 204
DATEVALUE, 256-257
DAY, 252-254
DAYS360, 203, 261-262 
EDATE, 266
EOMONTH, 266-268
MINUTE, 252-254
MONTH, 252-254
NETWORKDAYS, 268-270
NOW, 252
SECOND, 252-254
TIME, 256
TIMEVALUE, 256-258
TODAY, 252
WEEKDAY, 258-259
WEEKNUM, 259-261
WORKDAY, 268-271
YEAR, 252-254
YEARFRAC, 262-265

date calculations, 244-247

date filters, 740-743

DATE function, 204, 254-255

date math, formulas, 176-177

DATEDIF function, 204

dates
comparing, conditional 

formatting, 1007
formats, 247-251
formatting, Flash Fill, 28-29

dates argument 
XIRR function, 406
XNPV function, 405

date-stamping, keyboard 
shortcut, 117

DATEVALUE function, 204,
256-257

DAX (Data Analysis 
Expressions), 813

adding calculated columns, 
828

calculated fields, creating, 
832-835

calculations, 831-832

DAY function, 204, 252-254

DAYS function, 200, 204

DAYS360 function, 204, 261-262

DB function, 377, 395

DDB function, 377, 396-397

de Bruin, Ron, 101

DEC2BIN function, 552, 618

DEC2HEX function, 552,
616-617

DEC2OCT function, 552,
617-618

DECIMAL function, 185, 552,
614-616

decimals
converting between 

fractions, 422
converting number systems 

to, 614-616

declining-balance
depreciation, calculating, 395

defining worksheet-level 
names, 677-678

degrees, 550-556

DEGREES function, 550-556

delimiters, text, separating 
based on, 934

DELTA function, 552, 620-621

dependents, tracing, 182

depreciation
calculating, 397-400
cost, 393
declining-balance

depreciation, calculating, 
395



How can we make this index more useful? Email us at indexes@quepublishing.com

EFFECT function 1195

double-declining balance 
depreciation, calculating, 
396-397

salvage value, 393
sum-of-years’-digits,

calculating, 397
useful life, 393

descriptive statistics 
generating, 529
statistical functions, 439-459

Developer tab, 59

DEVSQ function, 456-459

DGET function, 371-373

dialog launchers, 52-53

dialogs
Add Watch, 182
Compress Pictures, 1104
Conditional Formatting 

Rules Manager, 1001
Create Pivot Table, 766
Data Table, 863
Edit Formatting Rule, 996
Evaluate Formula, 183-184
Excel Message, 1165
Excel Options, 63, 81, 85-90
External Data Range 

Properties, 640
File Open, 907
Find and Replace, 758-759
Format Cells, 52, 944
Format Comment, 983
Format Picture, 1126
Function Arguments, 

190-192
Go To, 132, 179
Greater Than, 1004-1006
Insert Function, 189-190
legacy, selecting commands, 

106-107
Name, 675-676
Name Manager, 687-689
New Formatting Rule, 52,

1009
Page Setup, 1112, 1121,

1124, 1134
Paste Options, 664
Printer Properties, 1115
Rank and Predictable, 530

Recommended Pivot Tables, 
764-765

Record Macro, 884
Rename, 82
Sampling, 538
Scenario Manager, 865-872
Sort, 724
Startup Prompt, 636
Summarize/Pivot, 1184
Top 10 Filter, 795-797
Update Links, 636
Zoom, 77

digital signature lines, 
workbooks, adding, 931-932

DISC function, 377, 414-415

discount argument, RECEIVED 
function, 412

discount bonds, calculating, 
417

displaying workbooks, two in 
two monitors, 5-9

distance, unit conversion, 
596-598

distance from origin, complex 
numbers, finding, 581

Document Inspector, 70

documents
choosing to print, 1130-1131
comparing side by side, 

synchronous scrolling, 928

DOLLAR function, 206, 289-291

dollar sign entry, simplifying, 
F4 key, 149-153

dollar signs, references, adding 
to, 117

DOLLARDE function, 377, 422

DOLLARFR function, 377, 422

double-declining balance 
depreciation, calculating, 
396-397

downloading Easy-XL utility, 
1175-1176

drawing objects, eliminating, 
1091

drill-down, Power View, 856

drop lines, surface charts, 
adding to, 1048-1049

drop-down lists, navigating, 
106

DSUM function, 367-371

duplicate entries, removing, 
733, 748-750

duplicate values, identifying, 
conditional formatting, 1008

DURATION function, 377,
420-421

dynamic named formulas, 
693-694

  E 
Easy-XL utility, 1175,

1187-1188
cleansing data, 1185-1186
columns

sorting left to right, 1184
text-to-columns feature, 

1182-1184
downloading and installing, 

1175-1176
fiscal years, 1187-1188
fuzzy matches, 1178-1181
recording commands into 

VBA macros, 1188
summarizing data, 1184-1185
tabular data, 1176
versus VLOOKUP, 1176-1178

EDATE function, 204, 266

Edit Formatting Rule dialog, 
996

editing
equations, 930-931
formulas, showing direct 

precedents, 180
macros, 896-897
workbooks

iPad, 1141-1142
Surface RT tablet, 

1142-1144

EFFECT function, 377, 392-393
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effect_rate argument, 
NOMINAL function, 393

effective interest rates, 
nominal rates, converting to, 
392-393

effects
pictures, applying effects, 

1100-1102
themes, reusing, 976-977

electrical engineering, bitwise 
operations, performing, 
610-613

elements, SmartArt, 1071
micromanaging, 1075-1077

emailing workbooks, Outlook, 
1163-1165

embedding workbooks in web 
pages, 1152-1154

ENCODEURL function, 185, 360

End key, navigating 
worksheets, 131

end_period argument 
CUMIPMT function, 390
CUMPRINC function, 391
VDB function, 399

energy, unit conversion, 
603-604

engineering functions, 549,
595-624

BASE, 552, 614-615
BESSEL, 623-624
BESSELJ, 552
BESSELK, 552
BESSELY, 552
BIN2DEC, 552, 618-619
BIN2HEX, 552
BIN2OCT, 552
BITAND, 552, 611-612
BITLSHIFT, 552, 612
BITOR, 552, 612
BITRSHIFT, 552, 613
BITXOR, 552, 612
COMPLEX, 552, 576-577
CONVERT, 552, 595-610 
DEC2BIN, 552, 618
DEC2HEX, 552, 616-617
DEC2OCT, 552, 617-618

DECIMAL, 552, 614-616
DELTA, 552, 620-621
ERF, 552, 622-623
ERFC, 552, 623
GESTEP, 552, 620-621
HEX2BIN, 552
HEX2DEC, 552, 617
HEX2OCT, 552
IMABS, 552, 581
IMAGINARY, 552, 577-578
IMARGUMENT, 552, 582-583
IMCONJUGATE, 552,

582-583
IMCOS, 552, 583
IMCOSH, 552, 583
IMCOT, 552, 583
IMCSC, 552, 583
IMCSCH, 552, 583
IMDIV, 552, 580
IMEXP, 552
IMLN, 552, 583
IMLOG2, 553, 583 
IMLOG10, 553, 583 
IMPOWER, 552, 582
IMPRODUCT, 552, 580
IMREAL, 552, 577-578
IMSEC, 552, 583
IMSECH, 552, 583
IMSIN, 552, 583
IMSINH, 552, 583
IMSQRT, 552, 582
IMSUB, 552, 580
IMSUM, 552, 578
IMTAN, 552, 583
OCT2BIN, 552
OCT2DEC, 552, 618
OCT2HEX, 552

English, converting to metric, 
595-610

enlarging, sparklines, 
1065-1066

entering
formulas, 145-154

arrow key method, 
154-156

mouse method, 154
same formula, many cells, 

156-159

EOMONTH function, 204,
266-268

equations
editing, 930-931
simultaneous linear, solving, 

584-595

ERF function, 552, 622-623

ERFC function, 552, 623

error functions, calculating, 
622-623

error messages, formulas, 
167-168

Esc key, closing Backstage 
view, 66

Evaluate Formula dialog, 
183-184

EVEN function, 201

EXACT function, 206, 289

Excel 2003, 140 
Alt shortcuts, invoking, 

118-119
creating file formats in, 140
keyboard accelerators, 

117-119

Excel 2010, limits, 130-131

Excel 2013 
signing in to, 9
Start screen, 9-12

Excel 2013 Pivot Table Data 
Crunching, 785

Excel Message dialog, 1165

Excel Options dialog, 63, 81,
85-90

new options, 86-87
settings, 85

Excel Starter, 1145

Excel Web App, 1135-1136
collecting survey data, 

1154-1158
designing workbooks as 

interactive web pages, 
1146-1154

versus Excel Starter, 1145
group-editing, 1144
limitations, 1144
PDF files, creating from 

worksheets, 1162-1163
SkyDrive workbooks, 

viewing, 1137-1145
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web tables, making 
interactive, 1158-1161

workbooks, sending via 
Outlook, 1163-1165

EXP function, 201, 572-575

expanding, Formula bar, 77

expanding tables, 707-708

EXPON.DIST function, 518

Exponential Smoothing 
feature, 535

Export command (File menu), 
66

extending selections, keyboard 
shortcuts, 107-111

External Data Range 
Properties dialog, 640

extraneous data, charts, 
deleting, 1023-1025

  F 
F4 key, dollar sign entry, 

simplifying, 149-153

FACT function, 201, 234-235

FACTDOUBLE function, 201

factor argument 
DDB function, 396
VDB function, 399

FALSE function, 307-308

Fast Fourier Transforms 
(FFTs), performing, 624-625

F.DIST function, 516-517

FFTs (Fast Fourier 
Transforms), performing, 
624-625

fields
pivot tables 

adding to, 766-768
calculated, 832-835
changing calculations, 

779-780
subtotals, adding by two 

fields, 760

Fields list, 766-770

file formats, 132-136
creating in Excel 2003, 140 
version compatibility, 

136-138
XLS, 127

File menu, 65-70

File menu commands, Print, 
1128-1130

File Open dialog, 907

files
opening in Excel 2002 or 

2003, 138 
opening in Excel 2007, 140 
opening same every day, 

927-928
pictures, compressing, 1104

fill handle, copying formulas, 
158-159

Filter button, 688

filter drop-downs, 721

filter panes, Power View, 
849-850

filtered results, sorting, 
743-745

filtering
Advanced Filter command, 

745-746
by color, 739-741
by icon, 739-741
improvements, 733-734
Name Manager dialog, 

687-689
pivot tables, 787

AutoFilter, 808
check boxes, 791-792
Label Filters, 787-797,

809
Label Filters fly-out, 

792-793
Report Filter, 797-800
Search box, 789-791
slicers, 800-804
timelines, 804-808

records, 733-743
by selection, 738-739
values, 620-621

filters, 734-735, 920-921
AutoFilter, 920-921
clearing, 737
columns, identifying, 

736-737
combining, 737
date, 740-743
drop-down

resizing, 737
selecting items, 735-736

Flash Fill, 29-32
number, 742-743
refreshing, 737
text, 742-743
unique records, 918-920

FILTERXML function, 185,
363-365

finance_rate argument, MIRR 
function, 403

financial functions, 375-376
ACCRINT, 377, 419-420
ACCRINTM, 377, 419-420
AMORDEGRC, 377
AMORLINC, 377
COUPDAYBS, 377
COUPDAYS, 377
COUPDAYSNC, 377
COUPNCD, 377
COUPNUM, 377
COUPPCD, 377
CUMIMPT, 375
CUMIPMT, 377, 390-391
CUMPRINC, 375, 377,

391-392
DB, 377, 395
DDB, 377, 396-397
DISC, 377, 414-415
DOLLARDE, 377, 422
DOLLARFR, 377, 422
DURATION, 377, 420-421
EFFECT, 377, 392-393
FV, 377, 386-387
FVSCHEDULE, 377, 422-423
INTRATE, 377, 412-413
IPMT, 375, 377, 388-390
IRR, 375, 401-403
ISPMT, 377
MDURATION, 377
MIRR, 377, 403-404
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NOMINAL, 377, 392-393
NPER, 377, 385-386
NPV, 377, 400-401
ODDFPRICE, 377, 414
ODDFYIELD, 377, 414
ODDLPRICE, 377, 414
ODDLYIELD, 377, 414
PDURATION, 375, 377, 381
PMT, 375, 377, 382-383
PPMT, 375, 377, 388-389
PRICE, 377, 409-411
PRICEDISC, 377, 417
PRICEMAT, 377, 416
PV, 377, 384-385
RATE, 377, 382-384
RECEIVED, 377, 411-412
RRI, 375, 377, 376-381
SLN, 377, 394-395
SYD, 377, 397
TBILLEQ, 377, 418
TBILLPRICE, 377, 419
TBILLYIELD, 377, 419
VDB, 377, 397-400
XIRR, 375, 377, 406
XNPV, 377, 404-405
YIELD, 377, 408-409
YIELDDISC, 377, 417
YIELDMAT, 377, 416

Find and Replace dialog, 
758-759

FIND function, 206

FINDB function, 206

first_interest argument, 
ACCRINTM function, 419

FISHER function, 428, 482-483 

five-icon sets, 999

FIXED function, 206, 289-291

Flash Fill, 21
cleaning data, 21-33
coaching, 23-25
commas, 26-27
filters, 29-32
formatting dates, 28-29
formatting telephone 

numbers, 25-26
joining text, 169
troubleshooting, 32-33

FLOOR function, 201

FLOOR.MATH function, 201

flow control, macros, 911-912

fly-out menus, ribbon, 50-51

fonts
changing size, 954-956
default, changing, 980
themes, 975
typeface, changing, 955-956

footers
scaling, 1128
using different, 1127-1128

force, unit conversion, 602-603

FORECAST function, 469-470

forecasting regression 
analysis, 472

Format Cells dialog, 52, 944
numeric formatting, 

changing, 947-949

Format Comment dialog, 983

Format Painter, 986-987

Format Picture dialog, 1126

Format Picture Task pane, 
1106

formats
copying, 984-989
date and time, 247-251
file, 132-136

creating in Excel 2003, 
140

version compatibility, 
136-138

Formats option (Paste Options 
gallery), 73

formatting
cells, styles, 1015-1016
chart elements, 1030-1033
conditional, 992

clearing, 1015-1016
combining rules, 

1015-1016
comparing dates, 1007
extending, 1016
formulas, 1011-1012
Highlight Cells Rules, 

1004-1009

pivot tables, 1016-1019
text containing values, 

1009
top/bottom rules, 

1002-1004
tweaking rules, 

1009-1014
dates, Flash Fill, 28-29
filtered results, 743-745
formula results, 710
formulas, automatically, 

174-176
macros, mail merge, 885-893
numeric, pivot tables, 

772-774
pictures, 1106
pivot tables, 784-785
reports, PowerPivot, 838-839
selected text, 76
slicers, 803
subtotal rows, 757-758
telephone numbers, Flash 

Fill, 25-26
worksheets, 941-943

adding cell comments, 
983-984

adjusting column widths 
and row heights, 
961-962

adjusting text in range, 
981-982

aligning cells, 954
changing numeric 

formats, 945-954
copying formats, 984-989
default fonts, 980
individual characters, 978
merging cells, 962-964
rotating text, 964-965
styles, 966-967
themes, 966-978
traditional, 943-965
wrapping text in cells, 

980-981

Formatting Category (Quick 
Analysis), 48

formatting data, keyboard 
shortcuts, 112

Formula bar, 71
expanding, 77
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formulas, 143-144, 163
absolute cell references, 

147-148
Advanced Filter, 746
auditing arrows, 181
automatic copying, stopping, 

709
building, 145-147
calculating, slow motion, 929
combining, 656-658
conditional formatting rules, 

1011-1012
copying, 172-174

fill handle, 158-159
table tool, 160-161

cutting, 172-174
date math, 176-177
dollar sign entry, simplifying, 

149-153
editing, showing direct 

precedents, 180
entering, 145-154

arrow key method, 
154-156

many cells, 156-159
mouse method, 154

error messages, 167-168
evaluating, 183-184
formatting automatically, 

174-176
highlighting all cells, 178-179
joining text, 169-172
moving tooltips, 184
names

assigning to, 662-666,
691-697

basic, 692
dynamic, 693-694
retroactively applying, 

681-682
operators, 163-166

order of operations, 
163-166

stacking multiple 
parentheses, 166

pivot tables, 783-784
R1C1-style, 903-906
references, mixed, 148
relative behavior, 145-147

overriding, 147-148

results, formatting, 710
simplifying, named ranges, 

679-687
structured references, 

referring to tables, 718
super, 651

3D, 652-655
array, 667-671

tables, adding to, 708-710
tracing dependents, 182
troubleshooting, 178-184
turning range on its side, 

664-666
versus values, 144-145
viewing all, 180
Watch Window, 182

Formulas & Number 
Formatting option (Paste 
Options gallery), 73

Formulas option (Paste 
Options gallery), 73

Formulas settings (Excel 
Options dialog), 85

Formulas tab, functions, 
187-188

FORMULATEXT function, 185,
342

four-icon sets, 999

fractions
converting between 

decimals, 422
displaying, 949

Frankston, Bob, 904

Freeform shape, 1087

Freeze Panes 
clearing, 703
using old versions, 704-705

freezing, worksheet panes, 
702-703

frequency argument 
ACCRINTM function, 419
PRICE function, 409
YIELD function, 408

FREQUENCY function, 494-496

F-test tool, measuring 
variability between methods, 
543-544

full screen, Print Preview, 1117

Function Arguments dialog, 
190-192

Function Wizard, 190-192

functions, 185-187
versus Analysis ToolPak, 548
ARABIC, 199
automating, 883
CountIf.3D, 100
cube, 358-359
database, 295, 301, 366-367

DGET, 371-373
DSUM, 367-371

date and time, 204-203, 252
DATE, 204, 254-255
DATEDIF function, 204
DATEVALUE, 256-257
DAY, 252-254
DAYS, 200
DAYS360, 203, 261-262 
EDATE, 266
EOMONTH, 266-268
MINUTE, 252-254
MONTH, 252-254
NETWORKDAYS, 268-270
NOW, 252
SECOND, 252-254
TIME, 256
TIMEVALUE, 256-258
TODAY, 252
WEEKDAY, 258-259
WEEKNUM, 259-261
WORKDAY, 268-271
YEAR, 252-254
YEARFRAC, 262-265

ENCODEURL, 185
engineering, 549, 595-624

BASE, 185, 552, 614-615
BESSEL, 623-624
BESSELI, 552
BESSELJ, 552
BESSELK, 552
BESSELY, 552
BIN2DEC, 185, 552,

618-619
BIN2HEX, 552
BIN2OCT, 552
BITAND, 186, 552,

611-612
BITLSHIFT, 186, 552, 612
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BITOR, 186, 552, 612
BITRSHIFT, 186, 552, 613
BITXOR, 552, 612
COMPLEX, 552, 576-577
CONVERT, 552, 595-610
DEC2BIN, 552, 618
DEC2HEX, 552, 616-617
DEC2OCT, 552, 617-618
DECIMAL, 185, 552,

614-616
DELTA, 552, 620-621
ERF, 552, 622-623
ERFC, 552, 623
GESTEP, 552, 620-621
HEX2BIN, 552
HEX2DEC, 552, 617
HEX2OCT, 552
IMABS, 552, 581
IMAGINARY, 552,

577-578
IMARGUMENT, 552,

582-583
IMCONJUGATE, 552,

582-583
IMCOS, 552, 583
IMCOSH, 186, 552, 583
IMCOT, 186, 552, 583
IMCSC, 552, 583
IMCSCH, 186, 552, 583
IMDIV, 552, 580
IMEXP, 552
IMLN, 552, 583
IMLOG2, 553, 583 
IMLOG10, 553, 583 
IMPOWER, 552, 582
IMPRODUCT, 552, 580
IMREAL, 552, 577-578
IMSEC, 186, 552, 583
IMSECH, 552, 583
IMSIN, 552, 583
IMSINH, 186, 552, 583
IMSQRT, 552, 582
IMSUB, 552, 580
IMSUM, 552, 578
IMTAN, 583
OCT2BIN, 552
OCT2DEC, 552, 618
OCT2HEX, 552

FILTERXML, 185

financial, 376
ACCRINT, 377, 419-420
ACCRINTM, 377, 419-420
AMORDEGRC, 377
AMORLINC, 377
COUPDAYBS, 377
COUPDAYS, 377
COUPDAYSNC, 377
COUPNCD, 377
COUPNUM, 377
COUPPCD, 377
CUMIMPT, 375
CUMIPMT, 377, 390-391
CUMPRINC, 375, 377,

391-392
DB, 377, 395
DDB, 377, 396-397
DISC, 377, 414-415
DOLLARDE, 377, 422
DOLLARFR, 377, 422
DURATION, 377, 420-421
EFFECT, 377, 392-393
FV, 377, 386-387
FVSCHEDULE, 377,

422-423
INTRATE, 377, 412-413
IPMT, 375, 377, 388-390
IRR, 375, 401-403
ISPMT, 377
MDURATION, 377
MIRR, 377, 403-404
NOMINAL, 377, 392-393
NPER, 377, 385-386
NPV, 377, 400-401
ODDFPRICE, 377, 414
ODDFYIELD, 377, 414
ODDLPRICE, 377, 414
ODDLYIELD, 377, 414
PDURATION, 375, 377,

381
PMT, 375, 377, 382-383
PPMT, 375, 377, 388-389
PRICE, 377, 409-411
PRICEDISC, 377, 417
PRICEMAT, 377, 416
PV, 377, 384-385
RATE, 377, 382-384
RECEIVED, 377, 411-412
RRI, 375-381
SLN, 377, 394-395

SYD, 377, 397
TBILLEQ, 377, 418
TBILLPRICE, 377, 419
TBILLYIELD, 377, 419
VDB, 377, 397-400
XIRR, 375, 377, 406
XNPV, 377, 404-405
YIELD, 377, 408-409
YIELDDISC, 377, 417
YIELDMAT, 377, 416

finding, 187-190
Formulas tab, 187-188
FORMULATEXT, 185
help, 190-192
INDIRECT, 658-662
inferential statistics, 485-524
information, 295-297

CELL, 320-323
INFO, 319-320
IS, 311-314
ISFORMULA, 312
ISREF, 316
N, 317
NA, 317-318
SHEET, 314-316
SHEETS, 314-316
TYPE, 323-324

ISFORMULA, 185
ISOWEEKNUM, 200
LastRow, 100
logical, 295-296, 300-302

AND, 302-304
FALSE, 307-308
IF, 300-302
IFERROR, 186, 308-310
NOT, 308
OR, 304-307
TRUE, 307-308

lookup, 295, 299-300
CHOOSE, 325
COLUMN, 330-332
FORMULATEXT, 342
HLOOKUP, 332-334
INDEX, 336-340
LOOKUP, 340-342
MATCH, 334-340
TRUE, 326-330
VLOOKUP, 326-332,

1176-1178
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mathematical, 200-201, 203
ABS, 231-232
AGGREGATE, 210-214
AVERAGEIF, 242-244
AVERAGEIFS, 186,

244-246
COMBIN, 199, 233
COMBINA, 199, 233-234
COUNT, 214-222
COUNTA, 214-222
COUNTIF, 242-244
COUNTIFS, 186, 244-247
FACT, 234-235
GCD, 234-236
LCM, 234-236
MOD, 237-238
MULTINOMIAL, 236-237
PI, 232
PRODUCT, 239-240
QUOTIENT, 238-239
RAND, 226-229
RANDBETWEEN, 226-229
ROMAN, 229-230
SIGN, 241
SQRT, 240-241
SUBTOTAL, 222-226
SUM, 192-194, 203-210
SUMIF, 242-244
SUMIFS, 186, 244-246

matrix, 549, 584-595
MDETERM, 550, 588-590
MINVERSE, 550, 586-588
MMULT, 550, 588-589
MUNIT, 588
SERIESSUM, 550, 590-591
SQRTPI, 592
SUMPRODUCT, 186, 550,

593-595
NBText, 100
new, 186-187
PageNum, 100
reference

ADDRESS, 349-351
AREAS, 344-345
GETPIVOTDATA,

355-358
HYPERLINK, 353-354
INDEX, 344-345
INDIRECT, 351-353
OFFSET, 346-349, 660

RTD, 355
TRANSPOSE, 354-355

RELATED, 832
SheetName, 100
statistical, 425-426

AVEDEV, 456-459
AVERAGE, 443-447
AVERAGEIF, 449-450
BETA.DIST, 514-516
BINOM.DIST, 487-489
BINOM.DIST.RANGE, 489
BINOM.INV, 489-491
CHISQ.TEST, 506-508
CONFIDENCE.NORM,

520-522
CONVARIANCE.P, 480
CORREL, 481-482,

535-538
descriptive statistics, 

439-459
DEVSQ, 456-459
EXPON.DIST, 518
F.DIST, 516-517
FISHER, 482-483
FORECAST, 469-470
forecasting, 469-474
GAMMA.DIST, 513-514
GAUSS, 501
GEOMEAN, 448
GROWTH, 475-476
HARMEAN, 448-449
HYPGEOM.DIST, 518-519
INTERCEPT, 462-463
KURTOSIS, 483-485
LARGE, 440-442
LINEST, 462-469, 531-533
logarithmic distributions, 

510-513
LOGEST, 473-474
MAX, 439-440
MEDIAN, 443-447
MIN, 439-440
NEGBINOM.DIST,

491-492
NORM.DIST, 496-497
NORM.INV, 497-498
NORM.S.DIST, 499-500
NORM.S.INV, 502
PEARSON, 477, 535-538
PERCENTILE.INC,

454-455

PERCENTRANK.INC,
455-456

PERMUT, 523
PERMUTATIONA,

523-524
PHI, 501-502
POISSON.DIST, 492-494
PROB, 519-520
QUARTILE.INC, 453
RANK, 450-453, 530-531
Regression, 459-485
renamed, 436-438
RSQ, 477-479
SKEW, 483-485
SLOPE, 462-463
SMALL, 442-443
STANDARDIZE, 503
STDEV.S, 456-459
STEYX, 479-480
sum of squares, 508-511
TDIST, 504-505
TREND, 471
TRIMMEAN, 447-448
T.TEST, 505-506
VAR.S, 456-459
WEIBULL.DIST, 519
Z.TEST, 522-523

text, 206
CHAR, 277-278
CLEAN, 275-277
CODE, 278-280
DOLLAR, 289-291
EXACT, 289
FIXED, 289-291
LEFT, 280-282
LEN, 282-283
LOWER, 272-274
MID, 280-282
non-English character 

sets, 293-294
NUMBERVALUE, 199,

291-292
PROPER, 272-274
REPLACE, 286-288
REPT, 288-289
RIGHT, 280-282
SEARCH, 283-286
SUBSTITUTE, 286-288
T, 293
TEXT, 289-291
TRIM, 274-275
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UNICODE, 199, 278-280
UPPER, 272-274

trigonometry, 549-551,
582-584

ACOS, 551, 563-564
ACOSH, 551, 568
ACOT, 186, 551
ACOTH, 551, 568
ASIN, 551, 563-564
ASINH, 551, 568
ATAN, 551, 563-564
ATAN2, 551, 564-565 
ATANH, 551, 568
COS, 551, 560-562
COSH, 551, 567
COT, 186, 551
COTH, 186, 551, 568
CSC, 186, 551
CSCH, 186, 551, 567
DEGREES, 550-556
EXP, 572-575
LN, 551, 572-575
LOG, 551, 571-572
LOG10, 550, 571 
logarithm, 569-575
RADIANS, 550-556
SEC, 186, 551
SECH, 186, 551, 567
SIN, 551, 559-560
SINH, 551, 567
TAN, 551, 558-559
TANH, 551, 567

UNICHAR, 199
web, 295, 300, 359-360

ENCODEURL, 360
FILTERXML, 363
WEBSERVICE, 360-365

WEBSERVICE, 185
WordCount, 100

future values, savings plans, 
estimating, 386-387

fuzzy matches, Easy-XL utility, 
1178-1181

fv argument 
IPMT function, 389
NPER function, 386
PDURATION function, 381
PMT function, 382
PPMT function, 388
PV function, 384

RATE function, 382
RRI function, 381

FV function, 377
future values, estimating, 

386-387

FVSCHEDULE function, 377,
422-423

  G 
galleries

options, selecting, 105-106
ribbon, 50-51

GAMMA.DIST function, 
513-514

GAUSS function, 501

GCD function, 201, 234-236

General settings (Excel 
Options dialog), 85

generating histograms, 
527-529

Geographic Heat Map, 94, 98

GEOMEAN function, 448

GESTEP function, 552, 620-621

GetOpenFileName macro, 
customizing, 907-908

GETPIVOTDATA function, 
355-358

GetSaveAsFileName macro, 
customizing, 907-908

Go To dialog, 132, 179

Goal Seek, 861, 872-877
troubleshooting, 876-877

graphics, SmartArt layouts, 
adding to, 1079-1080

gravity, emulating, 
trigonometry functions, 
566-568

Greater Than rules, 
highlighting cells, 1004-1006

grid
limits, 127-129
navigating, 131-132

gridlines, printing, 1132

group-editing, Excel Web App, 
1144

groups, sparklines, creating, 
1058-1060

GROWTH function, 475-476

guess argument 
IRR function, 402
RATE function, 382
XIRR function, 406

  H 
HARMEAN function, 448-449

headers
inserting pictures or 

watermarks, 1126
names, adding from, 684-686
printing, 1132
reports, adding, 1124-1126
scaling, 1128
tables, keeping in view, 

700-702
using different, 1127-1128

headlines, WordArt, 1088-1091

Help functions, 190-192

Hennig, Teresa, 84

HEX2BIN function, 552

HEX2DEC function, 552, 617

HEX2OCT function, 552

hexadecimal, converting to 
binary, 616

hidden content, finding, 70

hiding icons, 1002

hierarchical SmartArt, 
organizational charts, 
1081-1082

Hierarchy category (SmartArt), 
1071

Highlight Cells Rules, 
1004-1009

highlighting cells, Greater 
Than rules, 1004-1006

histograms, generating, 
527-529

HLOOKUP function, 332-334
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holiday ranges, converting to 
arrays, 270

Home tab, numeric formatting, 
changing, 945-946

Horizontal Multiples field 
(Power View), 851

HOUR function, 204

house payments, determining, 
384-385

hyperbolic trigonometry 
functions, 566-568

HYPERLINK function, 353-354

HYPGEOM.DIST function, 
518-519

  I 
icon sets, data segregation, 

999-1002

icons
filtering data by, 739-741
hiding, 1002
mixing, 1002
moving numbers closer to, 

1000-1001
New Sheet, 71, 75
QAT (Quick Access Toolbar), 

adding to, 62
Quick Analysis, 991
ribbon, selecting, 103-105
sorting data by, 725
white space, adding around, 

71

IF function, 300-301, 306-307

IFERROR function, 186

IMABS function, 552, 581

images. See also pictures  
screen clippings, inserting, 

1106-1108
sizing, 88
SmartArt layouts, adding to, 

1079-1080

IMAGINARY function, 552,
577-578

imaginary numbers, 576-584
reversing sign, 582-583

IMARGUMENT function, 552,
582-583

IMCONJUGATE function, 552,
582-583

IMCOS function, 552, 583

IMCOSH function, 186, 552, 583

IMCOT function, 186, 552, 583

IMCSC function, 552, 583

IMCSCH function, 186, 552, 583

IMDIV function, 552, 580

IMEXP function, 552

IMLN function, 552, 583

IMLOG2 function, 552, 583

IMLOG10 function, 552, 583

implicit intersections, 686-687

importing text files, 
PowerPivot, 824-826

IMPOWER function, 552, 582

IMPRODUCT function, 552, 580

IMREAL function, 552, 577-578

IMSEC function, 186, 552, 583

IMSECH function, 552, 583

IMSIN function, 552, 583

IMSINH function, 186, 552, 583

IMSQRT function, 552, 582

IMSUB function, 552, 580

IMSUM function, 552, 578

IMTAN function, 186, 552, 583

in-cell bar charts, creating, 
data bars, 992-997

INDEX function, 336-340,
344-345

INDIRECT function, 351-353
cell references, calculating in 

formula, 658-662

inferential statistics 
functions, 485-524
language, 485-487

Info command (File menu), 65

INFO function, 319-320

information functions, 295,
297-296

CELL, 320-323
INFO, 319-320
IS, 311-314
ISFORMULA, 312
ISREF, 316
N, 317
NA, 317-318
SHEET, 314-316
SHEETS, 314-316
TYPE, 323-324

Inquire, auditing worksheets, 
936-940

Insert Function dialog, 189-190

installation
Analysis ToolPak, 524-525
Easy-XL utility, 1175-1176

installing, Solver, 878

INT function, 201

intelligent tables, 699
defining suitable data, 

700-705
expanding, 707-708
filter drop-downs, 721
headers, keeping in view, 

700-702
rows, created banded rows, 

719-721

INTERCEPT function, 462-463

interest payments, calculating, 
390-391

interest rates 
compounding period, 

calculating, 392-393
determining, 382-384
loan payments, calculating, 

388-390

interface
File menu, 65-70
formula bar, 71
Formula bar, expanding, 77
mini toolbar, 71

formatting selected text, 
76

New Sheet, 75
Paste Options menu, 70
QAT (Quick Access Toolbar), 

61-64
ribbon, 49-61
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status bar, 71
adding numbers, 77-79

View control, 71
Zoom slider, 71

interfaces
MDI (Multiple Document 

Interface), 6
SDI (Single Document 

Interface), 6-8

internal rate of return, 
calculating, 403-404

intersection operator, two-way 
lookups, 685-686

intersections, implicit, 686-687

INTRATE function, 377,
412-413

invalid legacy naming, 683-684

investment argument 
INTRATE function, 413
RECEIVED function, 411

investments, calculating 
returns, 376-381

iPad, editing workbooks, 
1141-1142

IPMT function, 375, 377,
388-390

IRR function, 375, 401-403

IS function, 311-314

ISFORMULA function, 185, 312

ISOWEEKNUM function, 200,
204

ISPMT function, 377

ISREF function, 316

issue argument, ACCRINTM 
function, 419

italic type, applying, 956

  J-K 
JIS function, 206

JMT Utilities, 101

joining text, ampersand (&) 
operator, 271-272

J-Walk’s Power Utility Pack,

Kapor, Mitch, 249

Keep Source Formatting option 
(Paste Options gallery), 73

Key Performance Indicators 
(KPIs),  PowerPivot, defining, 
835-837

keyboard shortcuts, 103,
107-112

accelerators, 103-107
Excel 2003, 117-126 

calculating data, 112
columns, selecting data, 

711-712
commonly used, 116-117
data entry, 112
extending selections, 

107-111
formatting data, 112
legacy mode, 119
navigation, 109
selecting data and cells, 

107-110
Windows, 108

KeyTips, 103-104
ribbon, selecting icons, 

103-105

KPIs (Key Performance 
Indicators), PowerPivot, 
defining, 835-837

KURTOSIS function, 483-485

Kwyjibo, 883 

  L 
Label Filters 

filtering pivot tables, 809
pivot tables, filtering, 

787-788, 797

labeled hierarchy layouts 
(SmartArt), 1084

labeling charts, 1033-1035

labels
creating in Word from Excel 

data, 1169-1173
names, adding from, 684-686
sparklines, adding to, 

1066-1067

Language settings (Excel 
Options dialog), 85

Laporte, Leo, 751

LARGE function, 440-442

last task, repeating, keyboard 
shortcut, 117

LastRow function, 100

layouts, SmartArt 
adding images to, 1079-1080
categories, 1071-1072
changing, 1074
inserting, 1072-1074
labeled hierarchy, 1084

LCM function, 201, 234-236

LEFT function, 206, 280-282

LEFTB function, 206

left-to-right sorting, columns, 
727

legacy dialog boxes, 
commands, selecting, 106-107

legacy functions, unit 
conversion, 616-619

legacy mode, Excel 2003 
keyboard shortcuts, 119

legacy naming, invalid, 
683-684

LEN function, 206, 282-283

LENB function, 206

life argument 
DB function, 395
DDB function, 396
SLN function, 395
SYD function, 398
VDB function, 398

limited SmartArt, 1083

limits
grid, 127-128
rows, 128-129

linear equations, solving, 
matrix functions, 584-595

LINEST function, 462-469,
531-533
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links
creating

Alternate Drag-and-Drop 
menu, 631-632

mouse, 632
Paste Options fly-out 

menu, 629-630
external workbooks, 632
web workbooks, sharing, 

1149-1151
workbooks, creating, 634-636

Links tab (Trust Center), 
634-635

liquid measurement, unit 
conversion, 596-610

List category (SmartArt), 1071

live preview, 71

LN function, 551, 572-575

loan payments, interest rate, 
calculating, 388-390

LOG function, 551, 571-575

LOG10 function, 551

logarithm functions, 569-575

logarithmic distributions, 
functions, 510-513

logarithms
base-10, 569 
calculating, 571-575, 582-584

LOGEST function, 473-474

logical functions, 295-296,
300-302

AND, 302-304
FALSE, 307-308
IF, 300-302
IFERROR, 186, 308-310
NOT, 308
OR, 304-307
TRUE, 307-308

Longre, Laurent, 100-101

lookup functions, 295, 299-300
CHOOSE, 325
COLUMN, 330-332
FORMULATEXT, 342
HLOOKUP, 332-334
INDEX, 336-340
LOOKUP, 340-342

MATCH, 334-340
TRUE, 326-330
VLOOKUP, 326-332,

1176-1178

loops, macros, 908-916

LOWER function, 206, 272-274

  M 
macro recorder 

default state, 888-889
starting, 890-891

macros, 883, 908
calculation errors, fixing, 

906-907
combining a loop with 

FinalRow, 911
deleting records, 914-916
Easy-XL commands, 

recording into, 1188
editing, 896-897
example, 893-897
finding last row of data, 909
flow control, 911-912
formatting for mail merge, 

885-893
GetOpenFileName,

customizing, 907-908
GetSaveAsFileName,

customizing, 907-908
looping through all rows, 

909-910
recording, 884-885

blank workbook, 894-896
relative references, 890

referring to ranges, 910-911
reports, creating, 916-924
running, 892-893
security settings, checking, 

883-884
variables, 902-906

magnetism, unit conversion, 
606-607

mail merge, macros, 
formatting for, 885-893

managing
connections, 650
names, 687-689

manual calculation mode, 
pivot tables, 774

manually adding, page breaks, 
1123-1124

maps
Bing Maps app, 99
Power View, showing data 

on, 852-853

margins, worksheets, 
adjusting, 1118-1121

Martin, Robert, 84

MATCH function, 334-340

mathematical functions, 
200-201, 203

ABS, 231-232
AGGREGATE, 210-214
AVERAGEIF, 242-244
AVERAGEIFS, 186, 244-246
COMBIN, 199, 233
COMBINA, 199, 233-234
COUNT, 214-222
COUNTA, 214-222
COUNTIF, 242-244
COUNTIFS, 186, 244-247
FACT, 234-235
GCD, 234-236
LCM, 234-236
MOD, 237-238
MULTINOMIAL, 236-237
PI, 232
PRODUCT, 239-240
QUOTIENT, 238-239
RAND, 226-229
RANDBETWEEN, 226-229
ROMAN, 229-230
SIGN, 241
SQRT, 240-241
SUBTOTAL, 222-226
SUM, 203-210
SUMIF, 242-244
SUMIFS, 244-246

mathematical operators, 
formulas, 163-166

order of operations, 163-166
stacking multiple 

parentheses, 166

Matrix category (SmartArt), 
1071
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matrix functions, 549, 584-595
MDETERM, 550, 588-590
MINVERSE, 550, 586-588
MMULT, 550, 588-589
MUNIT, 588
SERIESSUM, 550, 590-591
SQRTPI, 592
SUMPRODUCT, 550, 593-595

Matrix view (Power View), 854

maturity argument 
DISC function, 414
INTRATE function, 413
PRICE function, 409
RECEIVED function, 411
YIELD function, 408

MAX function, 439-440

McCall, David, 572

MDETERM function, 550,
588-590

MDI (Multiple Document 
Interface), 6

MDURATION function, 377

measuring angles, 563-564

MEDIAN function, 443-447

Melissa virus, 883-884

menus
backing up one level 

through, 106
right-click, opening, 116

merging cells, 962-964

metric system, converting 
English to, 595-610

Microsoft Query connections, 
creating, 648-649

MID function, 206, 280-282

MIDB function, 206

MIN function, 439-440

mini toolbar, 71
displaying, 76
formatting selected text, 76

MINUTE function, 204, 253-254

MINVERSE function, 550,
586-588

MIRR function, 377, 403-404

mixing icons, 1002

MMULT function, 550, 588-589

MOD function, 201

models, solving, Solver, 
878-882

MODE.MULT function, 443-447

MODE.SNGL function, 443-447

month argument, DB function, 
395

MONTH function, 204, 252-254

MoreFunc.dll add-in, 100

mouse, creating links, 632

mouse method, entering 
formulas, 154

Moving Average command, 
534

MROUND function, 201

MULTINOMIAL function, 
236-237

MULTINOMINAL function, 201

Multiples (Power View), 851

MUNIT function, 588

  N 
N function, 317

NA function, 317-318

name box, 676-677

Name dialog, 675-676

Name Manager dialog, 687-689

named ranges 
formulas, simplifying, 

679-687
replacing with table 

references, 714-718

names, 673
absolute references, 

simplifying, 690
advantages, 673-675
cells, Name dialog, 675-676
formulas

assigning to, 662-666,
691-697

basic, 692
dynamic, 693-694
retroactively applying, 

681-682

headings, adding from, 
684-686

invalid legacy naming, 
683-684

labels, adding from, 684-686
managing, 687-689
name box, 676-677
phantom, 678
ranges, referring to, 682
rules, 674-675
updating, 89
values, holding, 690-691
worksheet-level, 677-678

navigation
drop-down lists, 106
grid, 131-132
keyboard shortcuts, 109

NBText function, 100

negative numbers, two’s 
complement, 619

NEGBINOM.DIST function, 
491-492

net present value 
calculating, 404-405
determining, 400-401

NETWORKDAYS function, 204,
268-270

NETWORKDAYS.INTL function, 
204

New command (File menu), 65

New Formatting Rule dialog, 
52, 1009

New Sheet icon, 71, 75

No Borders option (Paste 
Options gallery), 73

no_switch argument, VDB 
function, 399

NOMINAL function, 377,
392-393

nominal rates, effective 
interest rates, converting to, 
392-393

non-English character sets, 
text functions, 293-294

Normal View mode, 79

NORM.DIST function, 496-497
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NORM.INV function, 497-498

NORM.S.DIST function, 499-500

NORM.S.INV function, 502

NOT function, 308

NOW function, 204, 252

nper argument 
CUMIPMT function, 390
CUMPRINC function, 391
FV function, 386
IPMT function, 389
PMT function, 382
PPMT function, 388
PV function, 384
RATE function, 382
RRI function, 381

NPER function, 377, 385-386

npery argument 
EFFECT function, 392
NOMINAL function, 393

NPV function, 377, 400-401

number filters, 742-743

number systems 
converting to, 613-615
converting to decimal, 

614-616

numbers, 582-584
complex

adding, 578
breaking apart, 577-578
calculating angles to, 582
calculations, 582-584
converting a and b into, 

576-577
finding distance from 

origin, 581
performing basic math 

on, 579-580
imaginary, 576-584

reversing sign, 582-583
moving closer to icons, 

1000-1001
text, joining with, 169-172

NUMBERVALUE function, 199,
206, 291-292

numeric formatting, pivot 
tables, 772-774

  O 
object variables, macros, 

902-906

object.method (VBA), 898

OCT2BIN function, 552

OCT2DEC function, 552, 618

OCT2HEX function, 552

ODBC connections, setting up, 
646-649

ODD function, 201

ODDFPRICE function, 377, 414

ODDFYIELD function, 377, 414

ODDLPRICE function, 377, 414

ODDLYIELD function, 377, 414

Office, The, 91

OFFSET function, 346-349, 660

OLAP pivot tables, 830-831

OLE DB connections, setting 
up, 646-649

one-click data sorting, 729-730

one-click printing, 1112, 1115

OneNote, pasting Excel data 
to, 1165-1166

on-grid tooltips, 189-190

Open command (File menu), 66

Open panel, 14-19

Open Paste Special option 
(Paste Options gallery), 74

opening files 
Excel 2002 or 2003, 138-139
Excel 2007, 140

operators
ampersand (&), joining text, 

169-172, 271-272
comparison, 300-302
formulas, 163-166

order of operations, 
163-166

stacking multiple 
parentheses, 166

intersections, two-way 
lookups, 685-686

options, galleries, selecting, 
105-106

Options command (File menu), 
66

OR function, 304-307

organizational charts, 
hierarchical SmartArt, 
1081-1082

orientation, worksheets, 
adjusting, 1118

origins, complex numbers, 
finding distance from, 581

Outline view, 1186

Outlook, sending workbooks, 
1163-1165

  P 
Page Break preview mode, 79

page breaks, 1123
manually adding, 1123-1124
removing, 1124

Page Layout view, 79,
1131-1132

Page Setup dialog, 1112, 1121,
1124, 1134

PageNum function, 100

Paintbrush icon, styles, charts, 
1023-1025

panes, worksheets 
clearing Freeze Panes, 703
freezing, 702-703

par argument, ACCRINTM 
function, 419

parameters, VBA (Visual Basic 
for Applications), 898-901

parentheses, stacking 
multiple, 166

Paste as Linked Picture option 
(Paste Options gallery), 74

Paste as Picture option (Paste 
Options gallery), 74

Paste Link option (Paste 
Options gallery), 73
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Paste option (Paste Options 
gallery), 73

Paste Options dialog, 664

Paste Options fly-out menu, 70
links, creating, 629-630

Paste Options gallery, 73-74
accessing from Paste 

drop-down, 75
accessing from right-click 

menu, 74
options, 73-74
previewing paste, 71-73

pasting
conditional formats, 986
formats, 984-986
tables to Word, 1167
Word data to Excel text box, 

1168-1169

pasting data, charts, 1046

Patel, Keyur, 94

PDF files 
converting worksheets to, 

1162-1163
loading data, Able2Extract 

add-in, 100

PDURATION function, 375, 377,
381

Pearson, Chip, 477

PEARSON function, 477,
535-538

Peltier, Jon, 100

per argument 
IPMT function, 389
PPMT function, 388
SYD function, 397

PERCENTILE.INC function, 
454-455

PERCENTRANK.INC function, 
455-456

period argument 
DB function, 395
DDB function, 396

PERMUTATIONA function, 
523-524

phantom names, 678

PHI function, 501-502

PHONETIC function, 206

PI function, 201, 232

Picture Accent List style 
(SmartArt), 1070

Picture Accent Process style 
(SmartArt), 1070

Picture category (SmartArt), 
1071

Picture Styles gallery, presets, 
1100-1101

pictures, 1093. See also images 
adding captions to, 

1104-1105
applying effects, 1100-1102
arranging, 1108-1109
backgrounds, removing, 

1102-1104
compressing, 1104
formatting, 1106
headers, inserting into, 1126
inserting

from computer, 1093-1094
multiple at once, 1094
from online, 1094-1096

resizing, 1097-1099
rotating shape over, 1106
selecting, 1108-1109

pie charts, small slices, 
1051-1052

pivot tables, 761-762, 774-775,
785

blanks, removing, 772-774
browsing

Quick Analysis icon, 
763-764

Recommended Pivot 
Tables dialog, 764-765

building, 829-830
calculated fields, creating, 

832-835
calculations

adding outside, 778
changing of fields, 

779-780
changing reports, 768-770
Compact Form, 770-771
creating, 762-770
fields, adding, 766-768

filtering, 787
AutoFilter, 808
check boxes, 791-792
Label Filters, 787-797,

809
Label Filters fly-out, 

792-793
Report Filter, 797-800
Search box, 789-791
slicers, 787, 800-804
timelines, 804-808

formatting, 784-785
conditional, 1016-1019

formulas, 783-784
grouping daily dates to 

months and years, 775-777
joining multiple, Data Model, 

813-821
manual calculation mode, 

774
numeric formatting, 772-774
OLAP, 830-831
PowerPivot, 813-821, 830-831

benefits, 822
building reports, 824-830
combination layouts, 

837-838
enabling, 823
formatting reports, 

838-839
KPIs (Key Performance 

Indicators), 835-837
multiple relationships, 

840
QuickExplore, 837

rearranging, 772
refreshing, 839
replacing, 809-810
resources, 785
showing percentage of total, 

781
showing running totals and 

rank, 782-783
sorting, 810-812

Plus icon, charts, changing 
options, 1027-1028

pmt argument 
FV function, 387
NPER function, 385
PV function, 384
RATE function, 382
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PMT function, 375, 377, 382-383

POISSON.DIST function, 
492-494

populations, scatter charts, 
plotting two, 1041-1043

power, unit conversion, 
605-606

POWER function, 201

Power View, 841, 857
charts, replicating, 851
drill-down, 856
elements, creating by 

dragging, 847
Field List, 857
filter panes, 849-850
maps, showing data on, 

852-853
preparing data, 841-843
scatter charts, animating, 

855-856
slicers, adding, 847
tables, 854-855

converting to charts, 
844-847

Tile By field, 850-851
worksheets, creating, 

843-851

PowerPivot, 813, 830-831
adding calculated columns, 

828
adding data 

copying and pasting, 
826-827

linking, 827
benefits, 822
combination layouts, 837-838
DAX (Data Analysis 

Expressions)
calculations, 831-832
creating calculated fields, 

832-835
defining relationships, 827
enabling, 823
importing text files, 824-826
joining multiple tables, Data 

Model, 813-814, 821
KPIs (Key Performance 

Indicators), defining, 
835-837

pivot tables 
building, 829-830
multiple relationships, 

840
QuickExplore, 837
refreshing, 839
reports

building, 824-830
formatting, 838-839

SQL Server, data input, 839

PowerPivot for the Excel Data 
Analyst, 785

PowerPoint, Excel charts, 
using in, 1166-1167

PPMT function, 375, 377,
388-389

pr argument 
DISC function, 414
YIELD function, 408

presets, Picture Styles gallery, 
1100-1101

pressure, unit conversion, 
599-601

previewing, printed reports, 
1116-1121

PRICE function, 377, 409-411

PRICEDISC function, 377, 417

PRICEMAT function, 377, 416

principal, calculating total, 
391-392

principal payments, 
calculating, 388-389

Print command (File menu), 66

Print command (Print menu), 
1128-1130

Print panel, 1111
Print Preview pane, 

1116-1121

print ranges, worksheets, 
excluding part of, 1122

print titles, adding, 1121

Printer Properties dialog, 1115

printers
changing properties, 1131
choosing, 1130

printing
comments, 1133
controlling first page 

number, 1134
File menu, 1128-1130
gridlines, 1132
headers, 1132
one-click, 1112, 1115
page breaks, 1123-1124
Page Layout view, 1131-1132
replacing error values, 1133
reports, previewing, 

1116-1121
settings, 1112-1115

PROB function, 519-520

Process category (SmartArt), 
1071

PRODUCT function, 201,
239-240

Proofing settings (Excel 
Options dialog), 85

PROPER function, 206, 272-274

properties
VBA (Visual Basic for 

Applications), 900-902
web queries, managing, 640

protecting worksheets, 933

Puls, Ken, 84

pv argument 
CUMIPMT function, 390
CUMPRINC function, 391
FV function, 387
IPMT function, 389
NPER function, 385
PDURATION function, 381
PMT function, 382
PPMT function, 388
RATE function, 382
RRI function, 381

PV function, 377, 384-385

Pyramid category (SmartArt), 
1071

Pythagorean theorem, 556
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  Q 
QAT (Quick Access Toolbar), 

63-64
adding icons to, 62
commands, removing from, 

62
customizing, 62-63

QUARTILE.INC function, 453

Quick Access Toolbar settings 
(Excel Options dialog), 85

Quick Analysis icon, 991
browsing pivot tables, 

763-764

Quick Analysis, 21, 34-35, 48
adding charts to rows, 46
adding statistics to data, 

41-44
cells, color coding, 35-39
charting data, 39-40
creating summary reports, 

44-46

Quick Analysis, charts, 
summarizing data, 1043-1046

Quick Analysis Toolbar (QAT).  
See QAT (Quick Access 
Toolbar)

Quick Stats (Easy-XL), 1185

QuickExplore, pivot tables, 837

QUOTIENT function, 201,
238-239

  R 
R1C1-style formulas, 903-906

radians, versus degrees, 
550-556

RADIANS function, 550-556

RAND function, 201, 226-229,
525-527

RANDBETWEEN function, 201,
525-527

randomly sorting data, 730-732

range of formulas, turning on 
its side, 664-666

ranges
adjusting text in, 981-982
formulas, named, 679-687
referring to, names, 682

Rank and Predictable dialog, 
530

RANK function, 450-453,
530-531

rate argument 
ACCRINTM function, 419
CUMIPMT function, 390
CUMPRINC function, 391
FV function, 386
IPMT function, 389
NPER function, 385
NPV function, 401
PDURATION function, 381
PMT function, 382
PPMT function, 388
PRICE function, 409
PV function, 384
XNPV function, 405
YIELD function, 408

RATE function, 377, 382-384

RDBMerge add-in, 101

rearranging, pivot tables, 772

RECEIVED function, 377,
411-412

Recent File List, clearing, 68

Recent File List command (File 
menu), 66

Recommended Pivot Tables 
dialog, 764-765

Record Macro dialog, 884

recording macros, 884-885
blank workbook, 894-896
relative references, 890

records. See also  data 
deleting, 914-916
duplicate, removing, 733
filtering, 733-743
filters, unique records, 

918-920
finding last, 894

recovering, unsaved 
workbooks, 66-67

redemption argument 
DISC function, 414
INTRATE function, 413
PRICE function, 409
YIELD function, 408

reference functions 
ADDRESS, 349-351
AREAS, 344-345
GETPIVOTDATA, 355-358
HYPERLINK, 353-354
INDEX, 344-345
INDIRECT, 351-353
OFFSET, 346-349
RTD, 355
TRANSPOSE, 354-355

references
absolute, 147-148

simplifying, 690
adding dollar signs to, 

keyboard shortcut, 117
formulas, calculating in, 

658-662
mixed, 148
relative, macro recording, 

890
worksheet-level names, 

677-678

referencing tables, from 
outside, 715-717

refreshing
filters, 737
pivot tables, 839

regions, current, selecting, 116

regression analysis, 459-485
exponential regression, 476
forecasting, 472

reinvest_rate argument, MIRR 
function, 403

RELATED function, 832

Relationship category 
(SmartArt), 1071

relationship diagrams, 
building, 938-939

relationships, scatter chart 
variables, 1037-1043

relative behavior, formulas, 
145-147

overriding, 147-148
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relative references, macro 
recording, 890

Remove Duplicates data tool, 
747-750

removing
backgrounds, pictures, 

1102-1104
duplicates, columns, 748-750

Rename dialog, 82

renamed statistical functions, 
436-438

REPLACE function, 206,
286-288

REPLACEB function, 206

Report Filter, arranging filters, 
798

reports
building, PowerPivot, 

824-830
centering, 1132
changing, pivot tables, 

768-770
comments, printing, 1133
creating, macros, 916-924
formatting, PowerPivot, 

838-839
headers, adding, 1124-1126
previewing, 1116-1121
Scenario Summary, creating, 

868-870

REPT function, 206, 288-289

resizing
pictures, 1097-1099
window, ribbon, 57-58

results
cells, watching, 926-927
formulas, formatting, 710

retroactively applying names, 
formulas, 681-682

returns, investments, 
calculating, 376-381

reversing signs, imaginary 
numbers, 582-583

RGB (red, green, blue) color 
codes, 971

ribbon, 49-61
contextual tabs, activating, 

59
customization, 84
Developer tab, 59
dialog launchers, 52-53
finding lost commands, 60
fly-out menus, 50-51
galleries, 50-51
icons, selecting, 103-105
More command, 54-55
resizing window, 57-58
shrinking, 60-61
tabs, 52

adding, 83
task pane, 54-57

ribbon tab, resizing pictures, 
1097-1099

RIGHT function, 206, 280-282

RIGHTB function, 206

right-clicking data, columns, 
710-711

right-click menu, opening, 
keyboard shortcut, 116

ROMAN function, 201, 229-230

Rosling, Hans, 855

rotating text, 964-965

ROUND function, 201

ROUNDDOWN function, 201

ROUNDUP function, 201

rows
adding charts to, 46
banded, creating, 719-721
height, adjusting, 961-962
highlighting

entire, 1013
every other, 1014

limits, 128-129
subtotal

copying, 755-756
formatting, 757-758

Total
adding, 705-706
toggling, 706

RRI function, 375-381

RSQ function, 477-479

RTD function, 355

Ruble, Scott, 1027

rules
conditional formatting 

combining, 1015-1016
tweaking, 1009-1014

names, 674-675

running macros, 892-893

running totals, pivot tables, 
showing, 782-783

  S 
salvage argument 

DB function, 395
DDB function, 396
SLN function, 395
SYD function, 397
VDB function, 397

salvage value, depreciation, 
393

Sampling dialog, 538

Save As command (File menu), 
66

Save As panel, 14-19

Save command (File menu), 66

Save settings (Excel Options 
dialog), 85

savings plans, future plans, 
estimating, 386-387

scaling headers and footers, 
1128

scatter charts 
animating, Power View, 

855-856
plotting two populations, 

1041-1043
variable relationships, 

1037-1043

Scenario Manager, 865-868
adding scenarios, 869-872
Scenario Summary reports, 

creating, 868-870

screen clippings, inserting, 
1106-1108
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SDI (Single Document 
Interface), 6-8

Search box, filtering pivot 
tables, 789-791

SEARCH function, 206, 283-286

SEARCHB function, 206

SEC function, 186, 551

SECH function, 186, 551, 567

SECOND function, 204, 252-254

security, VBA, enabling, 884

security settings, checking, 
macros, 883-884

segregating data, icon sets, 
999-1002

SERIESSUM function, 550,
590-591

settings, printing, 1112-1115

settlement argument 
ACCRINTM function, 419
DISC function, 414
INTRATE function, 412
PRICE function, 409
RECEIVED function, 411
YIELD function, 408

shapes, 1069
cell contents, displaying 

content, 1084-1087
Freeform, 1087
pictures, rotating over, 1106
SmartArt, controlling, 

1077-1079

Share command (File menu), 
66

sharing, workbooks, 934

SHEET function, 314-316

SheetName function, 100

SHEETS function, 314-316

shortcut keys, navigating 
worksheets, 131

shortcuts (keyboard), 103,
107-112

accelerators, 103-107
Excel 2003, 117-119

calculating data, 112
columns, selecting data, 

711-712

data entry, 112
extending selections, 

107-111
formatting data, 112
legacy mode, 119
navigation, 109
selecting, 110-107
Windows, 108

shrinking ribbon, 60-61

SI (International System), 
converting English to, 
595-610

SIGN function, 201, 241

signatures, workbooks, 
adding, 931-932

signs, imaginary numbers, 
reversing, 582-583

simultaneous linear equations, 
solving, matrix functions, 
584-595

SIN function, 551, 559-560

Single Document Interface, 525

SINH function, 551, 567

Sisogenes, 249

sizes, fonts, changing, 954-956

SKEW function, 483-485

SkyDrive, 12-19
workbooks, viewing, 

1137-1145

slicers
adding, Power View, 847
arranging, 801-802
formatting, 803
grouped, 806-808
pivot tables, 787

filtering, 800-804

SLN function, 377, 394-395

SLOPE function, 462-463

slot-machining, 70

slow motion, formulas, 
calculating, 929

SMALL function, 442-443

SmartArt, 1069-1078
captions, 1104-1105
controlling shapes, text 

pane, 1077-1079

elements, 1071
micromanaging,

1075-1077
hierarchical, organizational 

charts, 1081-1082
layouts

adding images to, 
1079-1080

categories, 1071-1072
changing, 1074
inserting, 1072-1074
labeled hierarchy, 1084

limited, 1083
styles, 1070

Social Security numbers, 
displaying, 949

Solver, 861, 877-882
installing, 878

Sort dialog, sorting data, 724

sorting
columns, left to right, 1184
data, 723, 725

blank columns, 732
case sensitivity, 726-727
by color, 725
columns, left-to-right, 727
custom lists, 727-729
filtered results, 743-745
by icon, 725
one-click, 729-730
randomly, 730-732
Sort dialog, 724
troubleshooting, 731

pivot tables, 810-812

sparklines, 1055
axis values, controlling, 

1062-1064
charts, fitting into the size of 

a cell, 1055-1056
customizing, 1060-1061
data mapping, 1056-1067
enlarging, 1065-1066
groups, creating, 1058-1060
labels, adding to, 1066-1067
win/loss, setting up, 

1064-1065

Sparklines Category (Quick 
Analysis), 48

specialized sorting, 725-729
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spreadsheets, rows, limits, 
128-129

SQL Server 
connections, setting up, 

646-649
PowerPivot, data input, 839

SQRT function, 201, 240-241

SQRTPI function, 201, 592

square roots, numbers 
multiplied by pi, finding, 592

stacking multiple parentheses, 
166

STANDARDIZE function, 503

Start screen, 9-12
dismissing, 11-12

start_period argument 
CUMIPMT function, 390
CUMPRINC function, 391
VDB function, 399

Startup Prompt dialog, 636

statistical analysis, Analysis 
ToolPak, 524-548

statistical functions, 425-426
AVEDEV, 456-459
AVERAGE, 443-447
AVERAGEIF, 449-450
BETA.DIST, 514-516
BINOM.DIST, 487-489
BINOM.DIST.RANGE, 489
BINOM.INV, 489-491
CHISQ.TEST, 506-508
CONFIDENCE.NORM,

520-522
CONVARIANCE.P, 480
CORREL, 481-482, 535-538
descriptive statistics, 

439-459
DEVSQ, 456-459
EXPON.DIST, 518
F.DIST, 516-517
FISHER, 482-483
FORECAST, 469-470
forecasting, 469-474
GAMMA.DIST, 513-514
GAUSS, 501
GEOMEAN, 448
GROWTH, 475-476
HARMEAN, 448-449

HYPGEOM.DIST, 518-519
INTERCEPT, 462-463
KURTOSIS, 483-485
LARGE, 440-442
LINEST, 462-469, 531-533
logarithmic distributions, 

510-513
LOGEST, 473-474
MAX, 439-440
MEDIAN, 443-447
MIN, 439-440
NEGBINOM.DIST, 491-492
NORM.DIST, 496-497
NORM.INV, 497-498
NORM.S.DIST, 499-500
NORM.S.INV, 502
PEARSON, 477, 535-538
PERCENTILE.INC, 454-455
PERCENTRANK.INC,

455-456
PERMUT, 523
PERMUTATIONA, 523-524
PHI, 501-502
POISSON.DIST, 492-494
PROB, 519-520
QUARTILE.INC, 453
RANK, 450-453, 530-531
Regression, 459-485
renamed, 436-438
RSQ, 477-479
SKEW, 483-485
SLOPE, 462-463
SMALL, 442-443
STANDARDIZE, 503
STDEV.S, 456-459
STEYX, 479-480
sum of squares, 508-511
TDIST, 504-505
TREND, 471
TRIMMEAN, 447-448
T.TEST, 505-506
VAR.S, 456-459
WEIBULL.DIST, 519
Z.TEST, 522-523

statistics
adding to data, Quick 

Analysis, 41-44
descriptive, generating, 529
inferential, 485-524

status bar, 71
adding numbers, 77-79

STDEV.S function, 456-459

STEYX function, 479-480

stock charts, creating, 
1050-1051

straight-line depreciation, 
calculating, 394-395

structured references, 
formulas, referring to tables, 
718

styles
cells, 1015-1016
charts

Paintbrush icon, 
1023-1025

saving as templates, 
1052-1053

formatting worksheets, 
966-967

SmartArt, 1070

SUBSTITUTE function, 206,
286-288

Subtotal command, 751
automatic subtotals, adding, 

752
collapsed subtotal view, 

sorting, 754-755
one-page summaries, 753
subtotal rows 

copying only, 755-756
formatting, 757-758

subtotals, removing, 758
summing columns, while 

counting others, 758-759

SUBTOTAL function, 201,
222-226

subtotal rows 
copying only, 755-756
formatting, 757-758

subtotals
adding by two fields, 760
automatic, 751

adding, 751-752
collapsed subtotal view, 

sorting, 754-755
columns, summing, 758-759
one-page summaries, 753
removing, 758
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SUM function, 192-194, 201,
203-210

sum of squares, functions, 
508-511

SUMIF function, 201, 242-244

SUMIFS function, 186, 244-246

Summarize/Pivot dialog, 1184

summarizing data 
charts, Quick Analysis, 

1043-1046
Easy-XL utility, 1184-1185

summary reports, creating, 
Quick Analysis, 44-46

summing columns while 
counting others, 758-759

sum-of-years’-digits
depreciation, calculating, 397

SUMPRODUCT function, 186,
201, 550, 593-595

super formulas, 651
3D formulas, 652-655
array formulas, 667-671
cell references, calculating in 

formula, 658-662
formulas, combining, 

656-658
names, assigning formulas 

to, 662-666
range of formulas, turning 

on its side, 664-666

surface charts, drop lines, 
adding to, 1048-1049

Surface RT tablet, editing 
workbooks, 1142-1144

survey data, collecting, Excel 
Web App, 1154-1158

SYD function, 377, 397

symbols, cells, inserting in, 
930

synchronous scrolling, 
comparing documents side 
by side, 928

  T 
T function, 206, 293

Table Category (Quick 
Analysis), 48

Table Style Options group 
banded rows, creating, 

719-721
Total rows, adding, 705-706

table tool, formulas, copying, 
160-161

Table view (Power View), 
854-855

tables, 699. See also pivot 
tables

charts, 714-715
adding data, 1047

columns, selecting data, 
710-713

converting to charts, 844-847
defining suitable data, 

700-705
expanding, 707-708
filter drop-downs, 721
formulas, adding to, 708-710
headers, keeping in view, 

700-702
pivot, 761-762, 774-775, 785

adding calculations 
outside, 778

adding fields, 766-768
changing calculations of 

fields, 779-780
changing reports, 768-770
Compact Form, 770-771
conditional formatting, 

1016-1019
creating, 762-770
filtering, 787-797, 810
formatting, 784-785
formulas, 783-784
grouping daily dates 

to months and years, 
775-777

manual calculation mode, 
774

numeric formatting, 
772-774

rearranging, 772
removing blanks, 772-774
replacing, 809-810
resources, 785
showing percentage of 

total, 781
showing running totals 

and rank, 782-783
slicers, 787
sorting, 810-812

Power View, 854-855
references, replacing named 

ranges, 714-718
referencing from outside, 

715-717
rows

creating banded, 719-721
Total, 705-706

two-variable what-if, 
creating, 862-865

web, making interactive, 
1158-1161

Word, pasting to, 1167

tabs, ribbon, 52
adding, 83

tabular data, Easy-XL utility, 
1176

TAN function, 551, 558-559

TANH function, 567

task pane, 54-57

tasks
crossing off your list, 

keyboard shortcut, 116
last, repeating, 117

TBILLEQ function, 377, 418

TBILLPRICE function, 377, 419

T-bills, calculating, 418-419

TBILLYIELD function, 377, 419

TDIST function, 504-505

telephone numbers 
displaying, 949
formatting, Flash Fill, 25-26

temperature, unit conversion, 
606-609

templates, charts, saving, 
1052-1053
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text
formatting selected, 76
joining

ampersand (&) operator, 
271-272

formulas, 169-172
with numbers, 169-172

ranges, adjusting in, 981-982
rotating, 964-965
separating based on 

delimiters, 934
translating, 935
wrapping in cells, 980-981

text boxes, 1069
flowing long text passages, 

1089-1091
pasting Word data to, 

1168-1169

text files 
connections, setting up, 

641-645
importing, PowerPivot, 

824-826

text filters, 742-743

TEXT function, 206, 289-291

text functions, 206
CHAR, 277-278
CLEAN, 275-277
CODE, 278-280
DOLLAR, 289-291
EXACT, 289
FIXED, 289-291
LEFT, 280-282
LEN, 282-283
LOWER, 272-274
MID, 280-282
non-English character sets, 

293-294
NUMBERVALUE, 291-292
PROPER, 272-274
REPLACE, 286-288
REPT, 288-289
RIGHT, 280-282
SEARCH, 283-286
SUBSTITUTE, 286-288
T, 293
TEXT, 206, 289-291
TRIM, 274-275
UNICODE, 278-280
UPPER, 272-274

text pane (SmartArt), 
controlling shapes, 1077-1079

text-to-columns feature, 
Easy-XL utility, 1182-1184

themes
choosing, 969-970
colors, 973-975
creating, 971-978
effects, reusing, 976-977
fonts, 975
formatting worksheets, 

966-978

three-icon sets, 999

Tile By field (Power View), 
850-851

time calculations, 244-247

time formats, 247-251

TIME function, 204, 256

timelines, pivot tables, 
filtering, 804-808

time-stamping
keyboard shortcut, 117
unit conversion, 598-599

TIMEVALUE function, 204,
256-258

titles
print, adding, 1121
WordArt, 1088-1091

TODAY function, 204, 252

toggling, Total rows, 706

toolbars
mini, 71
QAT (Quick Access Toolbar), 

63-64

tools
Analysis Toolpack, 

performing FFTs, 624-625
fill handle, copying formulas, 

158-159
table, copying formulas, 

160-161

tooltips
formula, moving, 184
on-grid, 189-190

Top 10 Filter dialog, 795-797

top/bottom rules, conditional 
formatting, 1002-1004

Total rows 
adding, 705-706
toggling, 706

totaling, filtered results, 
743-745

Totals Category (Quick 
Analysis), 48

touch mode, 70
icons, adding white space 

around, 71

traditional formatting, 
worksheets, 943-965

translating, text, 935

TRANSPOSE function, 354-355

Transpose option (Paste 
Options gallery), 73

treasury bills, calculating, 
418-419

TREND function, 471

trendlines, charts, 1048-1049

trigonometry functions, 
549-551, 582-584

ACOS, 551, 563-564
ACOSH, 551, 568
ACOT, 186, 551
ACOTH, 551, 568
ASIN, 551, 563-564
ASINH, 551, 568
ATAN, 551, 563-564
ATAN2, 551, 564-565 
ATANH, 551, 568
COS, 551, 560-562
COSH, 551, 567
COT, 186, 551
COTH, 186, 551, 568
CSC, 186, 551
CSCH, 186, 551, 567
DEGREES, 550-556
EXP, 572-575
LN, 551, 572-575
LOG, 551, 571-572
LOG10, 551 
logarithm, 569-575
RADIANS, 550-556
SEC, 186, 551
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SECH, 186, 551, 567
SIN, 551, 559-560
SINH, 551, 567
TAN, 551, 558-559
TANH, 551, 567

TRIM function, 206, 274-275

TRIMMEAN function, 447-448

troubleshooting
Advanced Filter, 747
Flash Fill, 32-33
formulas, 178-184
Goal Seek, 876-877
sorting data, 731

TRUE function, 307-308,
326-330

TRUNC function, 201

Trust Center, Links tab, 
634-635

Trust Center settings (Excel 
Options dialog), 85

trusted document settings, 
88-89

T.TEST function, 505-506

Tufte, Edward, 46, 1021, 1055

two-variable what-if tables, 
creating, 862-865

two-way lookups, 
intersections, 685-686

type argument 
CUMIPMT function, 390
CUMPRINC function, 391
FV function, 387
IPMT function, 389
NPER function, 386
PMT function, 382
PPMT function, 388
PV function, 385
RATE function, 382

TYPE function, 323-324

typeface, changing, 955-956

  U 
Umlas, Bob, 656

unary minus, evaluating, 
164-165

underlining text, 956

UNICHAR function, 199, 206

UNICODE function, 199, 206,
278-280

unique values, identifying, 
conditional formatting, 1008

units of measurement, 
converting English to metric, 
595-610

unsaved workbooks 
creating links to, 634
recovering, 66-67

Update Links dialog, 
preventing from appearing, 
636

UPPER function, 206, 272-274

useful life, depreciation, 393

utilities
data analysis tasks, 102
Easy-XL, 1175-1176,

1187-1188
cleansing data, 1185-1186
downloading and 

installing, 1175-1176
fiscal years, 1187-1188
fuzzy matches, 1178-1181
recording commands into 

VBA macros, 1188
sorting columns left to 

right, 1184
summarizing data, 

1184-1185
text-to-columns feature, 

1182-1184
versus VLOOKUP, 

1176-1178
suites, 101

  V 
value arguments, NPV 

function, 401

Value Filters, pivot tables, 
filtering, 793

VALUE function, 206

values
axis, controlling, 1062-1064
duplicate, identifying, 1008

filtering, 620-621
formatting, 1010
versus formulas, 144-145
holding, names, 690-691
unique, identifying, 1008

Values and Number 
Formatting option (Paste 
Options gallery), 73

Values & Source Formatting 
option (Paste Options 
gallery), 73

values argument 
IRR function, 402
MIRR function, 403
XIRR function, 406
XNPV function, 405

Values option (Paste Options 
gallery), 73

variable scheduled interest, 
calculating future value, 
422-423

variables
macros, 902-906
scatter charts, relationships, 

1037-1043

VAR.S function, 456-459

VBA (Visual Basic for 
Applications)

code, 897-902
collections, 898
macros, 883, 908

combining a loop with 
FinalRow, 911

deleting records, 914-916
editing, 896-897
example, 893-897
finding last row of data, 

909
flow control, 911-912
formatting for mail 

merge, 885-893
GetOpenFileName,

customizing, 907-908
GetSaveAsFileName,

customizing, 907-908
looping through all rows, 

909-910
recording, 884-885, 890
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referring to ranges, 
910-911

reports, creating, 916-924
running, 892-893
security settings, 

checking, 883-884
object.method, 898
parameters, 898-901
properties, 900-902
security, enabling, 884

VBD function, 377

VDB function, 397-400

version compatibility, file 
formats, 136-138

versions, workbooks, 
comparing, 938-939

Vertical Multiples field (Power 
View), 851

View control, 71

viewing formulas, 180

views
Backstage, 65-66
Outline, 1186
Page Setup, 1131-1132

VLOOKUP function, 326-332,
1176-1178

  W 
Watch Window, formulas, 182

watermarks, headers, inserting 
into, 1126

Web App (Excel), 1135-1136
collecting survey data, 

1154-1158
designing workbooks as 

interactive web pages, 
1146-1154

versus Excel Starter, 1145
group-editing, 1144
limitations, 1144
PDF files, creating from 

worksheets, 1162-1163
SkyDrive workbooks, 

viewing, 1137-1145
web tables, making 

interactive, 1158-1161

workbooks, sending via 
Outlook, 1163-1165

web functions, 295, 300,
359-360

ENCODEURL, 360
FILTERXML, 363
WEBSERVICE, 360-365

web pages, connecting to data, 
637-640

web queries, properties, 
managing, 640

web tables, making 
interactive, Excel Web App, 
1158-1161

web workbooks 
designing, 1146-1154
sharing links to, 1149-1151

WEBSERVICE function, 185,
360-365

WEEKDAY function, 204,
258-259

WEEKNUM function, 204,
259-261

WEIBULL.DIST function, 519

weight and mass, unit 
conversion, 597

what-if analyses, 861-865

Windows keyboard shortcuts, 
108

win/loss sparklines, setting 
up, 1064-1065

Word
creating labels from Excel 

data, 1169-1173
pasting data to Excel text 

boxes, 1168-1169
pasting tables to, 1167

WordArt, 1069, 1088-1091

WordCount function, 100

workbooks, 627. See also 
worksheets

analyzing, 936
blank, recording macros for, 

894-896
Blank Workbook, 10-11

digital signature lines, 
adding, 931-932

displaying two in two 
monitors, 5-9

editing
iPad, 1141-1142
Surface RT tablet, 

1142-1144
embedding in a web page, 

1152-1154
getting information about, 

68-69
links, creating, 634-636
marking as final, 69-70
opening with links to closed 

workbooks, 635
page breaks, manually 

adding, 1123-1124
printing, 1130-1131
Recent File List, clearing, 68
sending via Outlook, 

1163-1165
shapes, 1069
sharing, 934
SkyDrive, viewing, 

1137-1145
SmartArt, 1069-1078

adding images to layouts, 
1079-1080

changing layouts, 1074
controlling shapes, 

1077-1079
elements, 1071
hierarchical, 1081-1082
inserting layouts, 

1072-1074
labeled hierarchy layouts, 

1084
limited, 1083
micromanaging elements, 

1075-1077
styles, 1070

text boxes, 1069
unsaved, recovering, 66-67
versions, comparing, 938-939
web

designing, 1146-1154
sharing links to, 

1149-1151
WordArt, 1069, 1088-1091
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worksheets
adding, 75
navigating through, 75-76
zooming in and out, 77

WORKDAY function, 204, 268,
270-271

WORKDAY.INTL function 204

worksheets, 627. See also 
workbooks

adding, New Sheet icon, 75
auditing, Inquire, 936-940
connecting two, 627-636
converting to PDF files, 

1162-1163
creating, Power View, 

843-851
formatting, 941-943

adding cell comments, 
983-984

adjusting column widths 
and row heights, 
961-962

adjusting text in range, 
981-982

aligning cells, 954
applying borders, 957-960
changing numeric 

formats, 945-954
coloring cells, 960-961
copying formats, 984-989
default fonts, 980
fonts, 954-956
individual characters, 978
merging cells, 962-964
rotating text, 964-965
styles, 966-967
themes, 966-978
traditional, 943-965
wrapping text in cells, 

980-981
links

creating using Alternate 
Drag-and-Drop menu, 
631-632

creating using Paste 
Options menu, 629-630

creating with mouse, 632
missing, 635

margins, adjusting, 
1118-1121

moving between, keyboard 
shortcut, 116

navigating through, 75-76
orientation, adjusting, 1118
panes

clearing Freeze Panes, 
703

freezing, 702-703
paper size, setting, 1118
print ranges, excluding part 

of, 1122
protecting, 933
spearing through, 3D 

formulas, 652-655
worksheet-level names, 

677-678
zooming in and out, 77

wrapping text, cells, 980-981

      X-Y-Z    
XIRR function, 375, 377, 406

XLS file format, 127

XML connections, setting up, 
646-649

XML file formats, 134-136

XNPV function, 377, 404

YEAR function, 204, 252-254

YEARFRAC function, 204,
262-265

YEN function, 206

YIELD function, 377, 408-409

YIELDDISC function, 377, 417

YIELDMAT function, 377, 416

yld argument, PRICE function, 
409

Yohe, Tom,

zero-coupon bonds, calculating 
price and yield, 416

ZIP codes, displaying, 949

Zoom slider, 71
switching between view 

modes, 79

zooming in and out on 
worksheets, 77
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